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Welcome to RND PipeWeb 

 

 
PipeWeb 

 
 
RND PipeWeb is a powerful software application for hydraulic analysis of liquid flow 
in pipe networks. It has a comprehensive graphical user interface that will appeal to 
chemical engineers and a versatile simulation engine. Apart from steady state flow 
conditions, the application also supports analysis of transient hydraulic shock effects, 
also known as water hammer, as well as time-dependent (extended period) 
simulation of gradual changes, such as liquid levels in tanks and tracer transport.  
 
RND PipeWeb is a full-fledged Microsoft Windows application, suitable for analysis of  
piping networks in such applications as the process industry and drinking water 
distribution. Among the many supportive features that make modeling with PipeWeb 
efficient and enjoyable are node and link template repositories, advanced result 
animation tools, and incorporated tables for ANSI pipe dimensions and minor loss 
coefficients.  
 
In this document, the names of user interface controls are written in bold, where 
suitable. The names of object properties in PipeWeb are written with a capital start 
letter, whereas property values are generally displayed in italic. Internal document 
hyperlinks are indicated by an alternative text color.  
 

Licensing and support 

RND PipeWeb can be used for any purpose at no monetary cost for an unlimited 
period of time. Purchase of a PipeWeb pro license removes a constraint in the 
maximum project size and grants access to excellent user support service for one 
year. The software is available for download at pipeweb.rnd.nl.  
  

System requirements 

Operating system: Microsoft Windows 10 or higher 64-bit.  
 
  

 

http://pipeweb.rnd.nl/
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1. The application workspace 

RND PipeWeb simulation models are constructed and operated in the workspace 
window. The workspace window is the principal user interface of the application. It is 
opened when the application is started, and the program exits when the workspace 
window is closed. 
 

 
 
This section starts with a discussion of the Application properties of the application 
and has separate topics for each of the elements of the workspace window: 
1. Viewport  The model construction environment. 
2. Link toolbox Contains templates for link creation. 
3. Node toolbox  Contains templates for node creation. 
4. Menu bar  Categorized list of commands. 
5. Design toolbar  Buttons for frequently used menu bar commands. 
6. Contour plot toolbar Controls hydraulic solver actions and display of color 

contours associated with hydraulic results 
7. Status bar  Displays the current layer of the viewport and controls 

various editing options. 
  
Additional characteristics of the behavior of the workspace are given in topics: 

• Layers 

• Blocks and fusions 

• Curve types 

• Viewport pages 
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1.1. Application properties 

RND PipeWeb is a stand-alone application. Multiple instances of PipeWeb may be 
started in the operating system, but you can only operate a single project in a 
PipeWeb instance.  
 
Projects are created, opened and saved by the usual commands New project, New 
Civil project, Open project, Save project and Save project as, which are available 
in the File menu of the Main window. Double-clicking a file extension associated with 
a RND PipeWeb file in Windows Explorer will open the file in a new instance of the 
application. Drag-dropping a file from Windows Explorer onto the viewport area of the 
Main window will open the file, after prompting to save the project being replaced. A 
PipeWeb instance is closed by the Exit command on the File menu or by clicking on 
the ‘X’-button on the title bar of the Main window.  
 

RND PipeWeb project file types 
There are three PipeWeb project file types: 

• The PipeWeb project file (extension: *.Pipeweb_project) 

• The PipeWeb node toolbox file (extension: *. PipewebNodeToolbox)  

• The PipeWeb link toolbox file (extension: *. PipewebLinkToolbox)  
 
The PipeWeb project file type supports storage of all information that can be 
contained in an RND PipeWeb simulation project, including picture components and 
all simulation data.  
 

Project types 
RND PipeWeb supports two project types. The standard project type is opened by 
the New project command in the File menu. Alternatively, the New epanet project 
command in the File menu creates a project of which the model configuration is 
consistent with the original EPANET application as introduced by the U.S. 
Environmental Protection Agency. The latter is intended for modelling of water 
distribution networks, whereas the standard project type was developed with 
chemical process engineering applications in mind. Both project types employ the 
open source EPANET solver for hydraulic analysis. The transient solver for 
shockwave simulation is available only for the RND PipeWeb standard project type.  
 
 

https://www.epa.gov/water-research/epanet
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1.2. Viewport 

A PipeWeb model is constructed and operated in the viewport area. It supports the 
following operations, using the mouse, the Menu bar, the toolbar, or the contextual 
menu of the viewport: 

• Add and delete nodes and links. 

• Cut, copy & paste nodes and links. 

• Group/Ungroup objects. 

• Merge objects into Blocks and Fusions. 

• Rearrange nodes. 

• Resize and edit nodes. 

• Edit link curves and change link connections 

• Change the display order of nodes. 

• Assign an object layer. 

• Create link templates and node templates 

• Operate simulations  

• Create a page background 
 

Node creation 
Nodes are added to the model by drag-dropping a template from the Node toolbox 
onto the viewport, using the mouse. Node objects added to the viewport are placed 
in the Active layer. They are represented by an image and a name tag.  

Link creation 
Link objects are depicted on the viewport by a curve and an optional name tag. Link 
creation is started by selecting a link template from the Link Toolbox. The finger 
mouse pointer indicates that the viewport is ready to receive instructions for 
construction of a new link object. If the mouse hovers over a connectable region of a 
node, the possibility for making a link connection is indicated by a change of the 
mouse pointer. The connection location on the node is indicated by a diamond or 
triangle marker. The connection is established by a left mouse button click on the 
connection location. The location at which a link connects to a node is called a knot.  
 
After the link start point has been created, each click on the viewport extends the 
curve path by addition of a control point, indicated by a small circle. Link construction 
is completed by creating a termination point using the same routine as for the start 
point. New link objects created on the viewport are placed in the Active layer. The 
curve type of a new link object is determined by the selected Curve type item in the 
Format menu. The orientation of the last segment of a link curve of type orthogonal 
can be switched between horizontal and vertical by holding down the space bar while 
the mouse hovers over a (non-auto arranged) destination connection point.  
 
A link end point connected to a newly created junction node can be made by clicking 
anywhere on the viewport while holding the Ctrl-key pressed.  
 
A node connected to the upstream side of a link is named the origin node of the link, 
while the link is referred to as a downstream link of the node. The node connected 
to the downstream side of the link is the destination node of the link, while the link is 
referred to as an upstream link of the node. Nodes can have an unlimited number of 
connected links.  
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Object selection 
Selected nodes and links are indicated in the viewport by a semi-transparent mask 
over the object in the selection color of the operating system. Selection of a single 
object is simply done by clicking on it in the viewport. The selection result depends 
on whether or not the Ctrl key and Shift key are pressed during the selection 
operation. 
 

Shift key state Ctrl key state Selection result 

released pressed remove from selection 

pressed released add to the selection 

released released start new selection 

 
To select/unselect several objects at the same time: Click with the left mouse button 
on an empty location on the viewport and move the mouse while keeping the mouse 
button pressed. A rectangle is displayed to indicate the operative region. The 
selection operation is executed when the mouse button is released. The result of this 
rectangular selection depends on the horizontal sweep direction. If the mouse was 
moved from left to right, only objects that lie completely inside the rectangle are 
affected. If the mouse is moved from right to left objects touching the rectangle are 
selected as well. The effect of pressing the Ctrl and Shift keys for to this selection 
method is the same as for selection of single objects by mouse clicks.  

Object rearrangement and duplication  
The position of nodes on the viewport can be changed by dragging their image 
across the viewport. If the control-button on the keyboard is pressed while starting 
the drag operation, the selected nodes and selected links connected to them are 
duplicated and subjected to the drag operation. As opposed to the copy/paste menu 
commands, duplication by mouse drag operation does not store the objects in the 
clipboard of the operating system. 

Object editing 
The Edit objects command of the Edit menu toggles the edit mode for selected 
objects in the viewport. In the edit mode, bounding box sizing handles and curve 
control points are displayed which can be used to change the objects in the viewport 
with mouse operations. The following object elements are available for modification: 

• Height and width of the node icon 

• Contour and connectivity of the link curve 

• Tag anchor location of the link  

• Size and location of the symbol text area 

• Contour of the symbol curve. 
 
Specific element types may be locked for all edited objects using the Edit options 
command of the Edit menu. Resizing handles are displayed as small rectangles on 
the edges of the bounding box of the element. Curve control points are displayed as 
small circles and the link tag location is indicated by an encircled cross sign. These 
markers can be selected in the same manner as objects are selected on the viewport 
by mouse operations. Objects are modified by dragging the selected markers using 
the mouse. The aspect ratio of resizing actions is preserved, unless Ctrl key is 
pressed. Curve control points can be duplicated by dragging a selected control point 
while keeping the Ctrl key pressed. Pressing the Del key removes the selected 
control points of the curve. The curve type of all edited node and link curves can be 
changed by selecting the desired Curve type item in the Format menu.  
 
Links can be detached from connected nodes by dragging the link end point away 
from the node. Reversely, links can be attached to a node by dropping the end point 
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on a suitable connection knot of a node. The knot is indicated by a marker in the 
shape of a diamond or a triangle. A vertical line inside a circle distinguishes the 
termination point of a curve from the start point. A polygon or spline curve with more 
than two control points is fully rescaled if one of the end points is dragged in the 
viewport. Alternatively, if the space bar is held down at the start of the drag operation, 
only the curve end point is displaced. For orthogonal link curves, the orientation of 
the first and last segment of a link can be switched between horizontal and vertical by 
holding down the space bar while the mouse hovers over a link end point other than 
an auto arranged node connection knot. Pressing the Esc key terminates the edit 
mode without storing any changes made to the selected objects. 

Viewport manipulation 
The viewport may be scaled and translated by dragging the mouse. The viewport is 
translated if the mouse is moved while keeping the right button pressed. The 
viewport is dynamically scaled if the Ctrl key is held down at the same time. The 
same behavior is obtained for the left button if the Pan button on the Toolbar is 
toggled on. In that case the right button scales the viewport without pressing the Ctrl 
key and the mouse cannot be used for object selection. 

 
The viewport may also be scaled by the Extend viewport command on the 

View menu and by the Zoom button on the Toolbar. The Zoom button enables 
scaling to a region specified by dragging the mouse. If the mouse is dragged in the 
Viewport after pressing the zoom button, a rectangle is drawn of the same aspect 
ratio as the Viewport, centered around the mouse-down location. The size of the 
rectangle corresponds to the viewport scaling factor applied when the mouse button 
is released. The scaling direction depends on the direction of the mouse 
displacement. If the mouse was moved from to the right the viewport scale range is 
decreased to the rectangle area scale range. If the mouse button was moved to the 
left, the viewport is expanded to the range that results from shrinking the Viewport 
area into the rectangle area. For a small mouse displacement, the viewport scaling 
factor remains unchanged and the center of the viewport is translated to the mouse 
location. 

Viewport contextual menu 
The contextual menu of the viewport is opened by a right mouse button click. The 
availability commands of this pop-up menu depends on the selected objects in the 
viewport and on the applied model properties. All commands that may appear in the 
contextual menu of the viewport are listed below, with a brief description of their 
function. 

• Cut/Copy/Paste Edit menu command clones 

• Editor options Clone of the corresponding options arrangement in 
the Edit menu. 

• Reset symbol text size Restores the default symbol text size of the edited 
nodes of which all text area sizing handles have 
been selected in object editing. 

• Align to Performs the action of the corresponding Edit menu 
item with the selected node indicated by the 
contextual mouse click location as reference 
location. 

• Reset chart scale range Restores the default scale range of the selected 
chart node indicated by the contextual mouse click 
location. 

• Open fusion window Performs the action of the corresponding Format 
menu Blocks command for the selected block or 
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fusion node indicated by the contextual mouse click 
location. 

• Create node template Performs the action of the corresponding 
Transform menu item for the selected node indicated 
by the contextual mouse click location. 

• Create link template Performs the action of the corresponding 
Transform menu item for the selected link indicated 
by the contextual mouse click location.. 

• Move arranged link up Changes the auto-arranged connection order at the 
node for the selected link and link connection side 
indicated by the contextual mouse click location. 

• Move arranged link down Changes the auto-arranged connection order at the 
node for the selected link and link connection side 
indicated by the contextual mouse click location. 

• Insert page reference Performs the action of the corresponding 
Transform menu item for the selected link indicated 
by the contextual mouse click location, regardless of 
the page location of the link origin and destination 
nodes. 

• Remove page reference Performs the action of the corresponding 
Transform menu item for the selected page 
reference node indicated by the contextual mouse 
click location. 

• Remove empty page Performs the action of the corresponding 
Transform menu item for an empty page indicated by 
the contextual mouse click location. 

•  
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1.3. Toolboxes 

Toolboxes are used to create objects in the viewport. There is a toolbox for link 
templates (Item 2 in the figure) and a toolbox for node templates (Item 3 in the 
figure). The toolboxes may be hidden by unchecking the Toolbox item on the 
View menu. 
 

 
 
The toolboxes contain one or several default templates. Node and Link objects in the 
viewport can be stored as new template in the toolbox by the Create template 
command from the Transform menu or the contextual menu of a selected object. A 
new template inherits all properties from the source object. Template properties 
cannot be changed.  
 
The default templates of the toolboxes include nodes and links representing EPANET 
Physical Components. In addition, the default node template Text can be used to add 
annotations to the worksheet.  

Link toolbox 
The link toolbox contains link templates. Links created on the viewport inherit all 
properties from the selected template in the link toolbox.  

Node toolbox 
The Node toolbox (Item 3) contains node templates. A new node object is created 
from a template by dragging a template from the toolbox and dropping it on the 
viewport.  

1.3.1. Toolbox properties 

The template images in the toolbox can be rearranged by drag-drop mouse 
operation.  
The toolbox properties can be modified by commands of the contextual menu of the 
toolbox. Besides the regular Cut, Copy, Paste and Delete items, the Toolboxes 
have the following contextual menu item: 

• Add category Creates a new category for template categorization. 

• Incrm. col. count Adds a column for template organization in columns. 

• Decrm. col. count Removes the right-most column. 

• Select children Selects all viewport objects created by the selected 
template. 

• Properties Opens a window which allows modification of the toolbox 
properties. 

• Config/Write Saves the toolbox properties and content to disk. 

• Config/Read Reads the toolbox properties and content from disk. 
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• Config/Import Adds toolbox content from disk to the present configuration. 

• Config/Restore Restores the default set of Toolbox templates. 
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1.4. Menu bar & Toolbar 

The Menu bar is located right underneath the title bar of the Main window. It has a 
series of commands grouped into drop-down menus. The most frequently used Menu 
bar commands are also available as a button on the Toolbar, which is located under 
the menu bar.  
 
The Menu bar commands are listed below, together with the corresponding Toolbar 
button icon, if existing, and a brief description of their function. 
 

File menu 
 New project Starts a new project and discards the current. 

 New epanet project Starts a new project with epanet model 
configuration and discards the current project.  

 
Open project Opens a project file. 

 
Save project Saves the current project. 

 Save project as Saves the current project after prompting for a file 
name. 

 Page setup  Opens the Page setup selection menu. 

 Print Prints the project to a printer. Requires a completed 
procedure for the above-mentioned page setup 
menu item. 

 Exit Closes the application without saving. 
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Edit menu 

 
Undo Undo the last mutation to the project. Clicking on the 

drop-down arrow opens a mutations list to select an 
item from. 

 
Redo Redo the last undone mutation to the project. 

Clicking on the drop-down arrow opens a list of 
undone mutations to select an item from. 

 Repeat Toggles the Repeat mode for object creation 

 
Cut Removes selected objects from the viewport and 

stores them in the Windows clipboard. 

 
Copy Copy the selected objects the viewport to the 

Windows clipboard. Also available as pop-up 
command on the viewport. 

 
Paste Paste objects from the Windows clipboard to the 

viewport. Also available as pop-up command on the 
viewport. 

 
Delete Delete objects selected in the viewport. 

 Edit objects Toggles the viewport object editing mode 

 Editor options Toggles editing of specific node elements, including 
symbol curves and text area size, node size and link 
tag anchor location  

 Find  Opens the Search utility to select nodes by string 
comparison. 

 Select Selects specific object types in the viewport. 

 Unselect Unselects specific object types in the viewport. 

 

View menu 

 
Extend viewport scale Rescales the viewport to fit the entire model. 

 Scrollbars Determines when the viewport scrollbars are 
displayed. Selecting the Auto option displays the 
scrollbars only if the model does not fit into the 
viewport. 

 Toolbox Hides the Toolbox when unchecked. 

 Toolbars Hides a specific toolbar when unchecked. 

 

Run menu 

 Solve hydraulics Resets the simulation run, and solves the hydraulic 
equation set for the model. Also available as button 
on the Hydraulics toolbar.  

 Run transient analysis Performs a transient simulation. Requires a 
successfully completed hydraulic solution. The 
transient simulation solver process can also be 
started, monitored and interrupted on the Hydraulics 
toolbar.  

 Clear data Discards all hydraulic and transient simulation data. 
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Format Menu 

 
Align Allows alignment of selected node objects. 

 Order Allows adjustment of the node z-order. Newly 
created nodes are placed on top of existing nodes.  

 
Group objects Joins the selected objects in the viewport into a 

group, forcing subsequent joint selection of all group 
members.  

 
Ungroup objects Breaks up all selected groups in the viewport. 

 Curve type Controls the curve type for new links and for curve 
editing. The selected type is reflected by the menu 
icon. The icon with no line indicates the link template 
default or the value <various>. 

 Blocks Manages blocks and fusions. 

 

Transform menu 
 Invert links direction Inverts the direction of the links selected on the 

worksheet  

 Make link chain 
unidirectional 

Realigns the direction of all of all selected links, 
provided the links selected form a continuous 
trajectory. 

 Swap link name Swaps the name properties of exactly two selected 
links 

 Reset symbol text size Adjusts the text area of symbol nodes to fill the 
symbol shape. 

 Create link templates Creates templates in the toolbox for all link objects 
selected in the viewport. 

 Create node templates Creates templates in the toolbox for all node objects 
selected in the viewport. 

 Insert page reference Inserts a page reference symbol pair on the selected 
links for which origin and destination nodes are on 
different pages . Requires a completed Page setup 
procedure. 

 Remove page reference Removes the selected page reference symbol pairs. 
Requires a completed Page setup procedure. 

 Remove empty pages Removes all pages that do not contain any node or 
link objects. Requires a completed Page setup 
procedure. 

 

Tools menu 
 Configuration Opens the Configuration window, as will double-

clicking the viewport. 

 Pictures Opens the Picture management console. 

 Layers Activates the Layer control panel.  

 Page background editor Opens the background editor window. Requires a 
completed Page setup procedure.  

 Preferences  Opens the Preferences utility to change preference 



 PipeWeb user's guide 

- 16 - 

settings of the application and the project. 

 
 

Window menu 
 Background Changes the background color of the viewport. 

 Arrange windows Opens the Window arrangement utility. 

 Windows list  Presents a list of all open window titles. Clicking on 
an item in the list activates the window.  

 

Help menu 
 Getting started Opens the Getting started section of the help 

document.  

 PipeWeb help Opens the help document. 

 PipeWeb website Opens the PipeWeb website in the default internet 
browser. 

 Check for updates Connects to the internet and checks if a more recent 
PipeWeb release is available for download. 

 About  Displays the application’s introductory splash 
window. Click the splash window to close it. 

 

Toolbar only commands 

 Pan Toggles left mouse button viewport manipulation. 

 Zoom Toggles the zoom function for viewport manipulation. 
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1.5. Hydraulics toolbar 

The Hydraulics toolbar is located beneath the viewport in the workspace window. The 
toolbar is used to start the hydraulic and transient solvers and to control results 
review by contour plots. 
 

 
 

1.5.1. Solver control 

The set of three buttons on the left represent solver control commands, which are 
also available on the Run menu. The left button starts the hydraulic solver. The 
middle button starts or cancels the transient solver procedure. The third button 
toggles message display on and off. The icon color of the latter reflects the content of 
the message list: Orange: List has critical messages which obstruct the solver 
procedure; Yellow: List has non-critical warnings; Green: List has info only, no 
warnings; None (disabled): List undetermined or no messages. The warnings list 
displays messages of either the hydraulic or the transient solver, whichever was last 
operated. The list is shown on top of the viewport and may be closed also by 
pressing the Escape key. 

1.5.2. Contour plot properties 

Contour plots mark a dedicated region of the default node icon on the viewport by a 
color associated with a range of hydraulic result values for a selected node 
parameter. A color legend displayed on the viewport indicates the applied parameter 
value ranges. A set of user-controlled options for the display style of the contour map 
in the viewport are discussed in section Reporting.  
 
The toolbar allows selection of the node parameter and a scheduling time point for 
the contour plot in the viewport. It also controls contour plot animation for schedule 
properties.  
  
The drop-down menu at the left, next to the solver command buttons, is used to 
select a node parameter for contour mapping. The time point for contour mapping 
can be adjusted using the mouse in the progress bar at the right. The forward button 
starts or pauses the animation, with the slider object in the middle controlling the 
animation speed. The animation stops at the last schedule time, but can be put into a 
continuous loop using the contextual menu of the progress bar. The rewind button 
returns the animation to the initial time point. Finally, two text labels on the toolbar 
indicate the time point selected for contour display. 
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1.6. Status bar 

The Status bar is located at the bottom edge of the window and is divided into 
panels, as indicated in the figure.  
 

 
 

Layer pane 
The Layer pane (Item 1) displays the name of the Active layer. Clicking the layer 
panel activates the Layer control panel.  

Mouse location panel 
The mouse location panel (item 2) displays the mouse x/y-coordinates on the 
viewport 

Viewport options panel. 
The viewport options panel (item 3) contains two toggle buttons. The Grid button 
toggles the display of the Page grid. The BKGND button toggles the display of the 
viewport Page background.  

Object snap panel 
The object snap panel (item 4) contains a set of four toggle buttons, which aid 
precise positioning of objects on the viewport. The Grid snap button enables 
snapping to the viewport page grid. The Object snap button enables snapping of 
node edges end link end points. The Ortho button results into preservation of 
vertical or horizontal coordinates of displaced viewport objects. The Drag threshold 
button implements a threshold distance for mouse drag operations, which can be 
used to prevent unintentional displacement of objects in the viewport by small mouse 
movements. The threshold also applies to viewport translation by mouse dragging.  
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1.7. Layers  

The node and link objects on the viewport are organized in layers. The layers have a 
specified color, and may be locked and hidden. The main purpose of layers is to 
cluster objects that are related in some meaningful way, for example by a shared 
function in the model. The organization of a project into layers offers many 
advantages to the project designer. The ability to hide layers and to apply different 
colors to layers makes it easier to visually distinguish objects in the viewport. Objects 
in locked layers cannot be selected in the viewport. 
 

Active layer 
New objects created on the viewport are placed in the layer that has been assigned 
active layer. The active or current layer can be identified in the Status bar and by the 
color of the default templates in the Toolboxes.  

Layer control panel 
The layers defined within project are managed by the Layer control panel, which is 
activated by a mouse click on the left-most panel of the Status bar or by the Layers 
command of the Tools menu. The Layer control panel is a pop-up control that 
presents a list of all layers defined for the project. It enables the creation and deletion 
of layers, modification of layer properties, and assignment of the current layer. It is 
also used to place objects on the viewport in a different layer.  
 

 
 
The column labeled Name displays the layer name. The layer name can be edited in-
cell, by double clicking the name field or by pressing a key on the keyboard. The 
assigned name must be unique and has the same format requirements as the Name 
property of nodes, links and components. The column labeled Color determines the 
default display color for objects contained in the layer. A click on the Color column 
activates a color selection dialog. The radio button in the third column identifies the 
Active layer of the viewport. The two other columns present additional layer 
properties indicated by an icon. The cross-out icon signifies that the layer is hidden. 
The padlock icon signifies that the layer is locked. A mouse-click on either of the two 
leftmost columns toggles the corresponding layer property.  
 
The Set object layer button appears on the Status bar when the Layer list is 
activated. By pressing this button, all selected node and link objects on the viewport 
are placed in the selected layer in the Layer list. New layers are created by the Add 
layer command of the contextual menu of the layer list. The Del key deletes the 
selected layers in the Layer list. 
 
While the layer panel is visible, the window's Menu bar & Toolbar are disabled, as 
are all other windows of the application. The Layer tool is deactivated by clicking on 
the viewport, or pressing the Escape key on the keyboard. 
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1.8. Blocks and fusions  

Blocks and fusion are named object sets that act as a single object. You can use 
them to create composed templates and compress specific parts of a model. They 
can help you save time and make your model easier to view. Block and Fusion nodes 
can be stored as node templates in the Toolbox. 

Blocks 
A set of node and link objects selected in the viewport can be joined into a block 
node. A block node represents the block members collectively by a single node in the 
viewport. The constituents of the block node cannot be individually selected, 
rearranged, edited or modified. Links can still be connected to the individual nodes 
contained in a block.  
 
The Create block command of the Blocks Format menu merges all selected objects 
on the viewport, including block nodes, into a new block node. The Explode block 
command reverses this transformation for all selected block nodes on the viewport. 

Fusions 
The Fuse blocks command of the Blocks Format menu transforms the selected 
block nodes in the viewport into fused block nodes. Fused block nodes are useful to 
represent a section of a project by a single node object. The default image of a fusion 
node is slightly different from the default node image.  
 

 
 

A link that is connected to a fused node, but not fused itself, is shown as connected 
to the fusion node in the viewport. Links can be connected to a predetermined 
destination or origin node contained in a fusion. The Unfuse blocks command 
transforms all selected fused block nodes back to a regular block node. 

Fusion window 
A fused block node may be displayed in a separate Fusion window. The Open 
fusion window command of the Blocks Format menu opens new fusion windows for 
all selected block and fusion nodes in the viewport. The fusion window is identical to 
the Workspace window, but does not have the File menu and some items in the Help 
menu. The fusion window permits modification of the block node by the same 
methods used in the viewport of the workspace window and supports all simulation 
Simulation display features. Changes made to the Layer control panel and the 
simulation control toolbar of the workspace window and fusion windows apply to all 
open windows. The Close block window command closes the block windows for all 
selected block nodes in the viewport. 
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1.9. Link curve types 

The shape of a link curves in the viewport is determined by the curve format type and 
a series of control points. The application supports the curve types Orthogonal, 
Polygon and Spline. 
 

 
Orthogonal   Polygon   Spline 

 
The curve types exist for display purposes only: they have no logical distinctions in a 
model.  
 

1.9.1. Link curve type selection 

The curve type of a link is determined by the Curve type item in the Format Menu.  
This control is available both for new links and for object editing.  
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1.10. Viewport pages 

Completion of the Page setup dialog of the File menu divides the viewport into 
pages. The specified page properties may be reviewed by the Page layout item of 
the Preferences console 
 

Page grid 
The Grid size item of the Preferences console allows definition of a page grid as 
reference for the arrangement of objects on a page. The page grid is only shown on 
viewport pages that have at least one node or link object. The grid can be hidden by 
the Grid button on the Viewport options panel. 

Drawings 
Each page on the viewport represents a drawing. The properties of a drawing are 
specified on the Specs tab of the Model console of the configuration window.  

Page background 
The Page background editor item on the Tools menu opens the background editor. 
The page background is drafted in the viewport of the background editor tool similar 
to the simulation model in the Workspace window, but cannot include link objects. 
The page background is displayed on every page of the workspace viewport. The 
properties of individual drawings can be expressed by text markup for node objects in 
the background. The page background can be hidden by the BKGND button on the 
Viewport options panel. Note that objects placed on the page background are not 
part of the simulation model. 

Page reference nodes 
A page reference node pair presents a method to systematically arrange page 
crossing links. A link is transformed into a page referencing link by the 
Insert page reference item of the Transform menu. This transformation spits the link 
into two parts on the viewport, each connected to a newly created page reference 
node. The page transition is depicted by placing each page reference node on the 
matching source or destination page of the original link, which will consequently be 
represented on both pages by either of the two split parts.  
 

 
 
The page reference nodes have no logical function in the simulation and the two link 
parts both represent the transformed link in the simulation. Simulation display is 
performed on both link elements. The page location of the page reference nodes can 
be expressed by text markup. The page reference construction is removed from a 
link by the Remove page reference item of the Transform menu.  
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2. Object configuration 

The Configuration window provides access to the properties of objects on the 
viewport and many other elements of the project. The window is opened by the 
Configuration menu on the Tools menu or by double-clicking the viewport.  
 

 
 
The category bar at the top of window selects the main category for which properties 
are displayed. Selecting a category displays the corresponding console with all 
relevant control items.  
 
The properties configured by the console categories are: 
Node Node object properties 
Link Link object properties 
Project  Properties of drawing objects or of the project itself 
Model General properties and properties of objects that are not represented 

on the viewport  
Results Simulation results and related information 
 
This chapter discusses property configuration on the Node, Link and Project 
consoles. Properties of the model are discussed in chapter Model configuration and 
the review of results is covered in chapter Results. 
 
Viewport context 
The configuration window can be opened from the Workspace window and from a 
Fusion window. The window from which the configuration window is opened 
represents the viewport context. The Node, Link and Project consoles only display 
and configure properties of objects that have the selected state in the viewport. For 
the Project console, Drawings are considered to be selected if one or more objects 
on the drawing have been selected. If no drawings are selected, the Project console 
references the current project. 
 
If the selected objects do not have a uniform value for a specific property, check 
boxes are grayed out, and pop menus are left empty, whereas in text fields and 
combo boxes the keyword <various> is displayed. In general, a control item on the 
console is disabled or hidden if it configures a property that does not affect any of the 
selected objects.  
 
The Topics tab strip beneath the category bar generally selects a group of properties 
that are related in some way. The composition of this tab strip can vary between the 
different consoles. The next sections in this chapter are organized by the items 
categorized on the Topics tab strip: 

• Specs 

• Display 

• History 

• Text 

• Network 

• Operation 
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2.1. Specs 

The Specs tab on the Node, Link and Project consoles presents general properties 
of selected nodes, links and drawings. If no drawings are selected, the Project 
console presents the properties of the project.  
 

 
 

Type name 
The Type name property may contain a maximum of 255 characters in the ranges A-
Z, a-z, 0-9 and the underscore _ character. The property must start with an 
alphabetic character and is case-insensitive. The name of an object consists of type 
name followed by the non-zero value of the below-mentioned Index property. When 
the Type name property is altered, the Index property may change for any of the 
selected objects to render the name property unique in the project. 

Index 
The index property of an object in an integer number >0. The name of an object 
consists of the above-mentioned type name followed by the non-zero index value. 
The name of each object is unique in the project. When the index property is 
changed, indexing of the selected objects starts with the specified value, where the 
index value of non-selected objects with the same type name are skipped. The 
default tag property of an object is the type name followed by a space and the non-
zero index. 

Description 
Descriptive text for the item. 

URL associations 
Displays a list of attached URLs to the selected viewport object, drawing or the 
project. 
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The Add item command of the contextual menu of the list adds a new untitled blank 
URL association to the list. The Edit name contextual menu command activates the 
edit mode of selected cell in the name column, as does pressing the space bar. The 
Edit URL contextual menu command activates the edit mode of selected cell in the 
URL column. The Browse file command allows opens a file selection dialog for 
assignment of a file URL to the selected item in the list. The Show in folder 
command opens a file URL in the system file browse. A double-click on the list 
opens the URL of the selected item with the appropriate system application.  
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2.2. Display 

The Display tab on the Node and Link consoles presents the display properties of 
nodes and link objects.  

2.2.1. Symbol format 

A node object is represented on the viewport by a constructed symbol, consisting of 
a base shape and several other elements. The base shape can be an ellipse, a 
polygon or a chart. The shape can be solid or transparent, can be rounded and 
rotated and may have a border. The symbol can also have a curve, a picture and text 
displayed on top of the base shape. All symbol properties are controlled of the 
Display tab, except for the text properties, which are controlled on the Text tab.  
 
 

 

Width 
Determines the width of the node in the viewport. The value is specified in the value 
selected for the Project base unit. The command Make symbols equilateral of the 
right-click activated contextual menu of the text field adjusts the Width property of 
symbol nodes to obtain an aspect ratio that renders polygons equilateral and ellipses 
circular. 

Height 
Determines the height of the node in the viewport. The value is specified in the value 
selected for the Project base unit. The command Make symbols equilateral of the 
right-click activated contextual menu of the text field adjusts the Height property of 
symbol nodes to obtain an aspect ratio that renders polygons equilateral and ellipses 
circular. 

Shape 
Determines the base shape of the symbol. Selection of the Chart value furnishes the 
symbol with an additional element to display numerical data in a chart diagram. 
Pressing the adjacent toggle button Config enables configuration of the chart 
properties as described in the Chart Configuration section.  
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Fill style 
Determines the fill style of the base shape. A click on the adjacent button opens a 
color section dialog that allows selection of the fill color. For the two Gradient values 
a second color button appears which represents the secondary gradient color.  

Shape tilt 
Tilts the symbol shape by 90-degree angle increments. 
 

Rounding 
Determines the corner rounding of the border within a range of 0 - 100%  

Border style 
Determines the border line style. A click on the adjacent button opens a color section 
dialog that allows selection of the border color. 

Border Width 
Determines the border width specified in mm.  

Rotation 
Determines the clockwise rotation angle of the symbol in degrees.  

2.2.2. Symbol elements 

 

 
 

Icon 
Determines the picture object to be displayed as icon in the node image. Type the 
name of the desired picture object or select it from the combo box.  

Icon fit 
Determines the arrangement of the above-mentioned icon in the symbol. Possible 
values are, Center (centered without size change), Scaled fit (scaled to fit the symbol 
with preservation of aspect ratio), Filled fit (stretched to fill the symbol), Tile 
(Repetitive tiling from top-left corner, cropped at left and bottom edges), Shrink 
(center and if larger than the symbol: Filled fit) 

Curve style 
Determines the curve line style. A click on the adjacent button opens a color section 
dialog that allows selection of the curve color. 

Curve weight 
Determines the curve width specified in the value selected for the Project base unit. 
The value Hairline represents the smallest value for the resolution of the selected 
printer.  
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2.2.1. Link arrow properties 

 

 
 

Arrow size 
Determines the distance of the arrow hand tip to the edge of the link curve, specified 
in mm or pixels. 

Rel. length 
Determines the length of the arrow as fraction of the above-mentioned size property. 
The default value of 1.732 for the standard link templates is consistent with an 
equilateral triangular arrow head. 

Fill extent 
Determines the length of the solid arrow area along the curve as fraction of the 
above-mentioned relative length property 

Solid line 
Forces a solid line for the arrow outline for dotted and dashed curve styles  

Serial 
Determines whether or not arrow display is repeated for every curve segment of a 
segmented curve. 

2.2.2. Link curve 

 

 
 

Style 
Determines the curve line style. A click on the adjacent button opens a color section 
dialog that allows selection of the curve color. 

Weight 
Determines the curve width specified in mm. The value Hairline represents the 
smallest value for the resolution of the selected printer.  

Tag seat 
Determines the tag location at the link curve in the range 0 to 1, where 1 denotes the 
destination location. 
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2.3. History 

The History tab on the Project console presents revision information of the project 
and of the drawings in the project. 

Revisions 
Displays a list of revision numbers of the selected drawings in the project and of the 
project itself. A drawing is selected if any of the viewport objects in the drawing are 
selected.  
 
The revision number is displayed in bold if a revision increment is pending because 
of modifications made to the drawing or the model since the last revision increment. 
Drawings obtain a pending revision increment if the drawing display on the worksheet 
changes or any of the drawing properties are altered. The project obtains a pending 
revision increment for any change made to the simulation model. 
 
The revision numbering format and updating method are controlled by the revision 
control item in the project preferences. For manual revision control, the lowest level 
revision number may be incremented manually by the Increment command of the 
contextual menu of the list. This command is effective only if a revision increment is 
pending. The Increment level submenus of the contextual menu allow increments of 
higher-level revision numbers. This action resets all lower revision numbers and 
removes pending increments. In case of a drawing revision change, the model 
revision is adjusted to match the largest revision number of the drawings 
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2.4. Text 

The Text tab on the Node and Link consoles presents the caption properties of 
nodes and link objects in the viewport.  

2.4.1. Scope 

The scope frame determines which properties are referenced by the other controls 
on the tab. Selecting the Symbol text option (not available for links) changes the 
scope from node and link tags to the text displayed in symbol nodes.  
 

 
 
Checking the Itemize box allows exclusion of individual objects by deselection in the 
list on the right, which presents a list of all node of link objects selected in the 
Viewport context of the configuration window.  
 
The other controls on the Text tab manage the text string to be displayed and the 
display style. 
 

 
 

String 
Determines the text displayed. Multiple lines are allowed. Text markup can be used 
to insert object properties in placeholders. Symbol text also recognizes clock escape 
sequences. Any combination of escape sequences can be used. All characters that 
do not represent an escape sequence are displayed as literal text.  

Font 
A click on the Font text field opens a Font selection dialog, which allows defining 
the text font properties. Note that for symbol text the font size is specified as 
percentage of the extent to fit the text region in the symbol. Clicking the adjacent 
color selection button opens a dialog for selection of the text color. A click on the 
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color button while pressing the Ctrl-key assigns the layer color to the text color. A 
click on the color button while pressing the Shift-key assigns the viewport foreground 
color to the text color.  

Hide 
Hides the text in the viewport 

Alignment 
Determines the horizontal text alignment. Possible values are Left, Center and Right. 
For tags only effective if the tag has multiple lines.  

Placement 
Determines the vertical text alignment. Possible values are Top, Middle and Bottom. 

Line spacing 
Determines the line spacing of the text display in the viewport, as fraction of the 
normal line spacing.  

Text rotation 
Determines the clockwise rotation angle of the link tag in degrees. An empty value of 
the text filed denotes alignment of the tag with the curve at the Tag seat location. Not 
available for nodes. 
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2.5. Network 

The Network tab on the Node and Link consoles configures the connection 
properties of nodes and link objects in the viewport.  

2.5.1. Link connection options 

The link connection options frame presents several node options that configure the 
manner by which new links are connected to the node.  
 

 
 

Refuse all connections 
If checked, links cannot be connected to the node.  

Auto arrange 
Determines the method by which link connections are organized. If checked, new link 
connections are snapped to the node edges in a uniformly spaced arrangement. If 
unchecked new links can be connected to any location on the node. Changing the 
value of the Auto arrange property does not affect existing link connections 

Refuse picture knots 
If checked, link connections cannot be snapped to picture knots of the symbol icon.  

Refuse knot on symbol text 
If checked, link connections cannot be snapped to the outline of symbol text.  

Outset edge knots 
If checked, links connections are shifted away from the node edge by half the curve 
width, such that the connected link curves do not overlap with the node image.  

2.5.2. Auto arrangement options 

Determines the arrangement of link connections under application of the above-
mentioned Auto arrange option. The control has three properties, organized in 
columns for the four sides of the node image as indicated in the first column. The 
Max. knots column determines the maximum number of permitted connections for 
each side. The value can be set by clicking the corresponding cell and typing the 
desired number. An empty field denotes that there is no limit to the number of 
connections. The check boxes in the Static column denote that the link connection 
spacing is predetermined in accordance with the specified Maximum knots value, 
independent of the number of connections. If checked, links can only be connected to 
a free knot position on the edge. The Spacing column determines the spread of the 
connections on the edge. A value between 0 and 1 can be specified, which denotes 
the relative length of connected section of the edge.  
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2.5.3. Connections 

The connections frame contains a list of all connections of the selected node or link 
objects.  
 

 
 
The list has 5 columns. The center column shows the name of the selected object. 
The two outer columns display the names of the connected origin and destination 
nodes for links or the names of the connected links on both sides for nodes. The two 
columns on either side of the center column labeled with a hashtag display the 
sequence position of the connection. The names of selected objects are displayed in 
the system’s selection highlight color in the two outer columns. For links, the 
destination and origin node can be changed by selecting another node name from 
the drop-down list that appears upon a mouse click on the popup-arrow at the edge 
of the list. 
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2.6. Operation 

2.6.1. Hydraulic object properties 

Operation type 
Selects the operation type of the node or link. The available options include the most 
common unit operations, such as a piping Junction, a liquid Reservoir, a Pump and 
various valve types. The link value Direct link signifies a non-dimensional frictionless 
link between a tank or reservoir and a valve or pump. 

Elevation 
The elevation in feet (meters) above some common reference of the node. This is a 
required property without default value. Elevation is used only to compute pressure at 
the node. It does not affect any other computed quantity. 

Length 
Pipe length of the link 

Feed flow rate 
The flow rate of fluid entering the system at the junction (negative values indicate 
fluid removed from the system). The text area on the right-hand side specifies the 
name of the time pattern used to characterize time variation for this property. The 
adjacent button opens the Time pattern utility, which can be used to create, modify, 
and select time patterns. Only available for the standard project type. Not applied if 
the junction is a transient Mitigator. 

Demand 
The average base demand for fluid by the main category of consumer at the junction. 
A negative value is used to indicate an external source of flow into the junction. The 
text area on the right-hand side specifies the name of the time pattern used to 
characterize time variation in demand for the main category of consumer at the 
junction. The pattern provides multipliers that are applied to the base demand to 
determine actual demand in a given time period. The adjacent button opens the Time 
pattern utility, which can be used to create, modify, and select time patterns. 
Equivalent of the above-mentioned Flow rate property for the epanet project type. 

Demand Categories 
When the ctrl-enter key is pressed in the text field of the above-mentioned Flow rate 
property, the Demand category editor is displayed. This tool allows base demands 
and time patterns to be assigned to self-defined categories of consumers at the 
junction. Only available for the epanet project type.  

Emitter rating 
Discharge capacity of an emitter (sprinkler or nozzle) placed at a junction, expressed 
as a given flow rate at a reference pressure value. Set to 0 if no emitter is present. 
See Emitters for more details. Only available for the epanet project type.  

Initial Level 
The height in feet (meters) of the liquid surface above the bottom elevation of the 
tank at the start of the simulation. A time pattern can be assigned to the level 
property if the Elevation and Diameter property are zero and Scheduling is applied. In 
that case, the text area on the right-hand side specifies the name of the level time 
pattern. The adjacent button opens the Time pattern utility, which can be used to 
create, modify, and select time patterns. 
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Liquid level min. / max. 
The minimum and maximum height in feet (meters) of the liquid surface above the 
bottom elevation of a tank. The tank level will not be allowed to drop below the 
minimum level and not to rise above the maximum level. 

Top inlet headspace height 
The height difference of the inlet nozzle level and the maximum liquid level in the 
tank. This property is applied to all inlet links connected to the tank. If the field is left 
empty (default), inlet links are connected to the bottom of the tank, at zero liquid 
level, as are all discharge links of the tank. 

Volume curve or diameter 
The (equivalent) diameter of a tank in feet (meters). The text field also accepts the 
name of a curve used to describe the relation between tank volume and liquid level. 
This property is useful for characterizing irregular-shaped tanks. The adjacent button 
opens the curve utility, which can be used to create, modify, and select volume 
curves. 

Pump Curve or power 
Numeric value of the power supplied by the pump, which assumes that the pump 
supplies the same amount of energy no matter what the flow is. The text field also 
accepts the name of a pump curve used to describe the relationship between the 
head delivered by the pump and the flow through the pump. The adjacent button 
opens the curve utility, which can be used to create, modify, and select pump curves. 

Speed factor 
The relative speed setting of the pump. For example, a speed setting of 1.2 implies 
that the rotational speed of the pump is 20% higher than the normal setting and a 
multiplier of zero implies that the pump will be shut off during the corresponding time 
period. The text area on the right-hand side specifies the name of the time pattern 
used to characterize time variation in pump speed. The adjacent button opens the 
Time pattern utility, which can be used to create, modify, and select time patterns. 
Leave blank if not applicable.  

Initial Status 
State of the pump or link (Active or Closed), or of the control valve or obstruction 
(Active, Open, Closed) at the start of the simulation period. For the values Open and 
Closed the setpoint of a control valve is ignored. The actual status can be altered 
during a simulation run using control statements. If a valve's initial status was Open 
or Closed, then it can be made active again using a control that assigns a value to 
the setpoint or loss coefficient. The link status value Closed is unavailable for links 
connected to a Check valve node or check valve links of the epanet project type. 

Efficiency  
The pump's wire-to-liquid efficiency (as fraction). The text field also accepts the name 
of an efficiency curve used to describe the relationship between  
pump efficiency and the flow rate. The adjacent button opens the curve utility, which 
can be used to create, modify, and select efficiency curves. The efficiency 
information is used only to compute energy consumption. Leave blank if the global 
Default pump efficiency is to be used.  

Internal diameter 
The internal diameter of the pipe, valve or obstruction. For pipes, clicking the 
adjacent button opens the Pipe size selector tool, which allows specification of the 
diameter value from a table of ANSI standard pipe sizes. A selected standard pipe 
size is indicated in the text field by a code containing schedule and nominal pipe size, 
rather than the actual diameter value. An empty text field leaves the diameter 
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undefined. For valve and obstruction nodes, the applied undefined diameter value is 
the smallest pipe diameter of all connected pipes. For an undefined diameter of a 
pipe link, PipeWeb seeks an appropriate value upstream of the link, which is 
indicated by a message if successful. 

Object Type 
The obstructor type: Bidirectional resistor or Check valve (non-return valve) 

Valve Type 
The valve type for pressure or flow rate control 

Setpoint  
The desired active setting of the control valve. 

Minor loss coefficient 
Unitless minor loss coefficient for the pipe. Clicking the adjacent button opens the 
pipe Minor loss evaluation tool, which allows calculation of the coefficient value for a 
range of valve types and other commonly used flow obstacles. 

Wall roughness 
The wall roughness coefficient of the pipe. It is unitless for Hazen-Williams or Chezy-
Manning roughness and has units of millifeet (mm) for Darcy-Weisbach roughness.  

Open state loss coefficient 
Unitless minor loss coefficient that applies when the valve is completely opened. The 
contextual menu items Calculate from Cv\Kv-value, convert a number specified in 
the text field to the loss coefficient value, provided the internal diameter property of 
the valve can be resolved.  

Head loss curve or coefficient 
Unitless minor loss coefficient that applies when an obstruction is in the Active status. 
The text field also accepts the name of a head loss curve used to describe the 
relationship between head loss and the flow rate. The adjacent button opens the 
curve utility, which can be used to create, modify, and select head loss curves. The 
contextual menu items Calculate from Cv\Kv-value, convert a number specified in 
the text field to the loss coefficient value, provided the internal diameter property of 
the valve has been specified. 

2.6.2. Tracing properties 

Initial concentration  
Species concentration at the node at the start of the simulation.  

Source type 
Selects the tracer source type for a storage or junction node where fluid enters the 
system. The options are: 
Feed concentration Fixes the concentration of any external inflow 

entering the network at a node. 
Mass flow rate Adds a fixed mass flow to that entering the node 

from other points in the network. 
Concentration supplement Fixes the concentration of any flow leaving the 

node (as long as the concentration resulting from 
all inflow to the node is below the setpoint). 

Concentration increase Adds a fixed concentration to that resulting from the 
mixing of all inflow to the node from other points in 
the network. 
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Source Quantity 
Baseline or average concentration (or mass flow rate, depending on selection for the 
above-mentioned Source type property) of source. The text area on the right-hand 
side specifies the name of the time pattern used to characterize time variation in 
source quantity at the node. The pattern provides multipliers that are applied to the 
base value to determine actual quantity in a given time period. The adjacent button 
opens the Time pattern utility, which can be used to create, modify, and select time 
patterns. 

Mixing Model 
The type of liquid quality mixing that occurs within the tank. The choices include 
Ideal Fully mixed (MIXED), 
Two-compartments (2COMP) 
Plug flow First-in-first-out (FIFO) 
Stagnant Last-in-first-out (LIFO) 
The text area on the right-hand side specifies the fraction of the tank's total volume 
that comprises the inlet-outlet compartment of the two-compartment (2COMP) mixing 
model. Not used for any other type of mixing models. See the Mixing Models topic for 
more information. 

Bulk rate constant 
The bulk reaction coefficient for chemical reactions in a tank or pipe. Use a positive 
value for growth reactions and a negative value for decay. Time units are 1/days. 
Leave blank if the Global bulk reaction constant is to be applied. See Liquid quality 
reactions for more information. 

Wall rate constant 
The wall reaction coefficient for the pipe. Use a positive value for growth and a 
negative value for decay. Time units are 1/day. Leave blank if the Global wall 
reaction constant is to be applied. See Liquid quality reactions for more information. 

2.6.3. Transient properties 

Action type 
Selects the transient operation type options for non-Junction nodes (Pump, valve, 
obstruction). The available options are: 
None Normal operation, no specific transient actions.  
Modulate Changes the pump speed factor or head loss coefficient in 

accordance with a pre-determined profile. 
Close \ Trip Invokes a pump trip or completely closes a valve or obstruction 

at a controlled rate. 
For the value None control valves keep their controlling function and pumps continue 
to run during the transient operation. 

Start time 
Start time of the transient operation 

Transition duration 
Duration time of the transient operation 

Transition rate exponent 
Specifies the constant m in the rate function (1 - τm) by which the modulated property 
varies in time, where τ is the dimensionless transient operation time (0 to 1). The 
transition is linear for m = 1, accelerating for m > 1, and decelerating for m < 1. 

Final speed factor  
Final value of the speed factor of a pump, at the end of the modulation operation.  



 PipeWeb user's guide 

- 38 - 

Final loss coefficient  
Final value of loss coefficient of a control valve or obstruction, at the end of the 
modulation operation.  
 

Design rotational speed 
Rotational speed at design conditions of the pump  

Angular momentum 
Angular momentum at steady state. Pressing the adjacent button displays a popup 
window that assists in estimation of the Angular momentum value. 

Valve characteristic 
Name of the characteristic curve for the obstruction or control valve. The valve 
characteristic curve defines the value of the object's flow coefficient Cv/Kv as a 
function of the open percentage status or stem travel of the instrument. The transient 
closing operation causes a decrease of the open percentage status from the steady-
state value to zero at a rate determined by the other transition parameters applied. 
Press the adjacent button to define or select a characteristic curve for the valve. If no 
characteristic curve is specified, a linear decrease of the flow coefficient with the 
stem travel is applied. An error message is displayed if the steady-state flow 
coefficient value is outside of the characteristic curve range. 

Elbow locations 
Specifies a pattern for the elbow locations pattern for unbalanced pipe force 
evaluation on pipe sections divided by elbows. The text area specifies the name of 
the time pattern used to characterize the relative distance of elbows along the length 
of the pipe. The adjacent button opens a Pattern utility, which can be used to create, 
modify, and select elbow location patterns. If the text filed is left empty no elbows are 
assumed to be present and the pipe force on the entire pipe is evaluated.  
 
Mitigator node properties 

Mitigator type 
Selects the mitigator type for junction nodes. The available options are: 
None No transient mitigation actions.  
Gas accumulator The node represents a vessel with a compressed gas chamber 

separated from the liquid content by a moving interface, such 
as a  

piston, bladder or membrane. 
Relief valve The node represents a relief valve that opens and closes at 

predetermined pressure setpoints. 
Rupture disk The node represents a disk that that breaks at a predetermined 

pressure. 
Standpipe The node represents a vertical pipe open to the ambient air at 

the top.  
 
The applied value of the Feed flow rate property of a junction node depends on the 
selected value for this mitigator type property. For all transient mitigators (with 
selected value <> None) the property is ignored, and no feed flow is applied in the 
hydraulic solver. For transient junctions (value = None) the property is constant in the 
transient solver independent of the node pressure. 
 

https://en.wikipedia.org/wiki/Flow_coefficient
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Gas accumulator properties 

Tank diameter 
Diameter of the cylindrical reservoir. 

Tank height  
Total height of both chambers of the cylindrical reservoir. 

Polytropic index 
A constant in the gas compression and expansion process of the accumulator. The 
default value 1.4 represent adiabatic conditions.  

Precharge pressure 
The initial pressure of the gas chamber in the accumulator before start-up of the 
hydraulic system. 
 
Relief valve properties 

Opening pressure 
Pressure at which the surge relief valve opens. 

Reseating pressure 
Pressure at which the surge relief valve shuts. Cannot be greater than the above-
mentioned Opening pressure. The difference between the Opening pressure and 
Reseating pressure is often referred to as blowdown. If unspecified, the relief valve 
pops open at the Opening pressure property, and never closes again after opening.  

Valve flow coefficient Cv 
The value of the flow coefficient Cv of the surge relief valve in fully open state. Only 
available if the US Customary option is selected for the Base unit system property. 

Valve flow factor Kv 
The value of the flow factor Kv of the surge relief valve in fully open state. Only 
available if the Metric option is selected for the Base unit system property. 

Back pressure 
Specifies the (piezometric) backpressure of a surge relief valve or rupture disk 
mitigator, as constituent of the pressure differential driving force for the mitigating 
flow. It is assumed that reversed flow occurs if the node pressure of an open valve or 
rupture disk is lower than the back pressure. If unspecified for a relief valve, the valve 
will discharge into a connected downstream link. In that case the node must have a 
single upstream and a single downstream connected link to be functional. Otherwise 
the discharged liquid is removed from the system. 
 
Relief valve mechanism properties 

Valve type 
Selects the operation method applied to the relief valve. The specific pressure control 
parameter that governs valve operation depends on the below-mentioned Balanced 
property of the valve. The Valve type value Pop action results into immediate 
opening of the valve when the pressure control parameter exceeds its’ 
Opening pressure property. The valve remains completely opened until it closes 
when the control parameter becomes smaller than the Reseating pressure property 
of the valve. For the value Modulating action, the Kv- or Cv-value of the valve 
changes linearly with the control parameter until the control parameter reaches the 
Max. modulating pressure. Further details on relief operation mechanism specifics 
may be obtained from the white paper: The Function, Advantages And Limitations Of 
Pilot-Operated Safety Valves. 

https://en.wikipedia.org/wiki/Polytropic_process
https://en.wikipedia.org/wiki/Flow_coefficient
https://en.wikipedia.org/wiki/Flow_coefficient
https://www.leser.com/en/the-company/neuigkeiten/news/posv-whitepaper/
https://www.leser.com/en/the-company/neuigkeiten/news/posv-whitepaper/
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Balanced 
The operation action of a balanced relief valve, such as a bellows-sealed spring 
valve, is independent of the downstream pressure. In that case the governing control 
parameter for valve operation is the upstream pressure at the valve. If the valve is 
not balanced, the control parameter is the difference between upstream pressure and 
back pressure. 

Max. modulating pressure 
The value of the pressure control parameter above which the valve is completely 
open. The modulating operation and the significance of the Maximum modulating 
pressure and other relief valve properties are depicted in the figure below.  
 

 
 
This property is not available for the Pop action value for the above-mentioned Valve 
type property. 
 

Min. transition time 
The minimum duration of the opening and closing actions of the relief valve. Limits 
the change rate of the Cv- or Kv-property of the valve to 100% / Max transition time. 
Not available for the Pop action pilot value for the above-mentioned Valve type 
property. 
 
Rupture disk properties 

Burst pressure  
Pressure at which the rupture disk breaks. 

Discharge coefficient Cd 
Value of the discharge coefficient of the aperture of the rupture disk 

Aperture diameter 
Diameter of the aperture of the rupture disk. 
 
Stand pipe properties 

Pipe diameter 
Diameter of the standpipe. 

https://en.wikipedia.org/wiki/Discharge_coefficient
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Pipe length 
Length of the standpipe. Determines the maximum liquid level in the pipe, resulting in 
overflow of the standpipe if liquid continues to enter the pipe. 
 
Check valve properties 

Closing velocity 
Flow velocity at which the check valve closes. Enter a negative number for reversed 
flow. Note that a check valve is implemented within the transient operation of any 
pump node, with the default value 0 for the Closing velocity property as well as for 
the below-mentioned Required opening head property.  

Required opening head 
Head differential across the valve required to re-open a closed check valve. 
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3. Model configuration 

The configuration window provides access to general properties of the model and 
many other elements of the project. The window is opened by the Configuration 
menu on the Tools menu or by double-clicking the viewport.  
 

 
 
The category bar at the top of window selects the main category for which properties 
are displayed. Selecting a category displays the corresponding console with all 
relevant control items.  
 
The Model console contains general properties of the model that are not associated 
with objects represented on the viewport.  
 
This chapter discusses the model property configuration, organized by the available 
tabs on the topics tab strip beneath the category bar: 

• Hydraulic 

• Solver 

• Scheduling 

• Transient 

• Nodes 

• Tracing  / Quality 

• Controls 

• Reporting 
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3.1. Hydraulic 

Head loss equation 
Formula used to compute head loss as a function of flow rate in a pipe. Choices are: 

• Hazen-Williams 

• Darcy-Weisbach 

• Chezy-Manning 
Because each formula measures pipe roughness differently, switching formulas 
might require that all pipe roughness coefficients be updated. 

Base unit system 
Preselect the default units in which properties and results are expressed.  

Unit flow rate 
Selects the units for expression of flow rate 

Unit pressure  
Selects the units for expression of pressure (gauge). 

Unit pressure differential 
Selects the units for expression of pressure differentials 

Density 
Liquid density  

Viscosity 
Kinematic viscosity of the liquid  

Default pump efficiency 
Global default pump efficiency value 
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3.2. Solver 

Maximum Trials 
Maximum number of trials used to solve the nonlinear equations that govern network 
hydraulics at a given point in time. Suggested value is 40. 

Accuracy 
Convergence criterion used to signal that a solution has been found to the nonlinear 
equations that govern network hydraulics. Trials end when the sum of all flow 
changes divided by the sum of all link flows is less than this number. Suggested 
value is 0.001. 

Maximum Head Error 
Augments the ACCURACY option. Specifies the maximum head loss error any 
network link can have for hydraulic convergence to occur. The default value of 0 
indicates that no head error limit applies. Units of this parameter are feet (US) or 
meters (SI). 

Maximum Flow Change 
Augments the ACCURACY option. Specifies the largest change in flow that any 
network element (link, emitter, or pressure- dependent demand) can have for 
hydraulic convergence to occur. The default value of 0 indicates that no flow change 
limit applies. It is specified based on the current project flow unit setting. 

CHECKFREQ 
This sets the number of solution trials that pass during hydraulic balancing before the 
status of pumps, check valves, flow control valves and pipes connected to tanks are 
once again updated. The default value is 2, meaning that status checks are made 
every other trial. A value equal to the maximum number of trials would mean that 
status checks are made only after a system has converged. (Whenever a status 
change occurs the trials must continue since the current solution may not be 
balanced.) The frequency of status checks on pressure reducing and pressure 
sustaining valves (PRVs and PSVs) is determined by the DAMPLIMIT option (see 
below). 

MAXCHECK 
This is the number of solution trials after which periodic status checks on pumps, 
check valves, flow control valves and pipes connected to tanks are discontinued. 
Instead, a status check is made only after convergence is achieved. The default 
value is 10, meaning that after 10 trials, instead of checking status every 
CHECKFREQ trials, status is checked only at convergence. 

DAMPLIMIT 
This is the accuracy value at which solution damping and status checks on PRVs and 
PSVs should begin. Damping limits all flow changes to 60% of what they would 
otherwise be as future trials unfold. The default is 0 which indicates that no damping 
should be used and that status checks on control valves are made at every iteration. 
Damping might be needed on networks that have trouble converging, in which case a 
limit of 0.01 is suggested. 

Continue if unbalanced 
Action to take if a hydraulic solution is not found within the maximum number of trials. 
Choices are STOP to stop the simulation at this point or CONTINUE to use another 
10 trials, with no link status changes allowed, in an attempt to achieve convergence. 
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Below are some typical values that might be used for the status 
checking parameters: 

TYPICAL VALUES FOR STATUS CHECKING PARAMETERS 

CHECKFREQ MAXCHECK DAMPLIMIT REMARKS 

2 10 0 Frequent status checking; 
tends to produce solutions in 
the least number of 
iterations. 

10 100 0.01 Less frequent status 
checking; might be needed 
for networks that have 
difficult in converging. 

Max. Trials Max. Trials Convergence 
Accuracy 

Status checks made only 
after convergence is 
achieved; might produce 
convergence when other 
settings fail. 
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3.3. Scheduling 

 

Simulation duration time 
Total length of a simulation in hours. Use 0 to run a single period (snapshot) 
hydraulic analysis. 

Hydraulic Time Step 
Time interval between re-computation of system hydraulics. Normal default is 1 hour. 

Tracing Time Step 
Time interval between routing of liquid tracing/quality constituent. Normal default is 5 
minutes (0:05 hours). 

Pattern Time Step 
Time interval used with all time patterns. Normal default is 1 hour. 

Pattern Start Time 
Hours into all time patterns at which the simulation begins (e.g., a value of 2 means 
that the simulation begins with all time patterns starting at their second hour). Normal 
default is 0. 

Reporting Time Step 
Time interval between times at which computed results are reported. Normal default 
is 1 hour. 

Report Start Time 
Hours into simulation at which computed results begin to be reported. Normal default 
is 0. 

Clock start time 
Clock time (e.g., 7:30 am, 10:00 pm) at which simulation begins. Default is 12:00 am 
(midnight). 
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3.4. Transient 

Transient simulation time 
Specifies the transient simulation time span. Leave empty to disable transient 
analysis.  

Liquid bulk modulus 
Specifies the compressibility of the liquid. The default value of 2.15 represents the 
value for water at room temperature.  

Piping Young's modulus 
Specifies the elasticity of the liquid. The default value of 200 is representative for 
carbon steel at room temperature.  

Pipe friction model 
Selects the friction model applied to transient pipe flow. The available options are: 
Adopt from steady state Uses the friction factor value determined for each pipe 

by the steady state hydraulics solver as a constant 
value.  

Darcy-Weisbach Evaluates pipe friction losses for each pipe as a 
function of transient velocity in accordance with the 
Darcy-Weisbach friction model.  

Unsteady Vardy-Brown Evaluates pipe friction losses for each pipe as a 
function of transient velocity using a well-established 
convolution-based friction model. This option is the 
most demanding for CPU resources. 

 

Cavitation model 
Liquid may evaporate at some point in a piping system if the pressure becomes 
smaller than the saturated vapor pressure of the liquid. Initially, the vapor created will 
form small bubbles or cavities in the liquid. RND PipeWeb allows accounting for the 
effect of such evaporation phenomena by using the Discrete vapor cavity model 
(DVCM) to calculate the volume fraction of vapor in a pipe. The DVCM is generally 
considered to be accurate up to vapor volume fractions of 10%.  

Saturated vapor pressure 
Specifies the saturated vapor pressure of the liquid as reference for the above-
mentioned cavitation model. 

Pipe segmentation aim 
Specifies the desired mean of the number of discrete segments per pipe for all pipes 
in the transient solver. The accuracy of the solution increases with the pipe segment 
count at the cost of higher CPU load.  

Discretization characteristics 
The Discretization characteristics frame provides an overview of the discretization 
properties of the model. A number of key parameter values are displayed together in 
a concise list. The table is updated automatically after each simulation run. Pressing 
the update button refreshes the table to the values applicable to the next simulation 
run for the present model configuration and value of the above-mentioned property: 
Pipe segmentation aim. The discretization properties displayed in the list are: 
Time step Simulation time step in seconds 
Time step count Total number of time steps in the simulation. 
Min. pipe segment count Minimum number of segments in a pipe. 
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Max. pipe segment count Maximum number of segments in a pipe. Note 
that values above 25 do normally not offer 
significant additional accuracy. 

Min. oscillation count Minimum number of wave oscillations for all pipes 
in the system expressed as:  

  (simulation time) / (4 * pipe wave travel time). 
Max. wave speed adjustment The solution method applied requires some 

adjustment of the pipe wave speeds in order to 
satisfy the condition of equal wave travel time for 
all pipe segments in the model. The reported 
value indicates the maximum % adjustment 
applied to all pipes in the model. A value of 0% is 
the best attainable result.  

CPU load An indicator to the computational effort required 
for the simulation, expressed as: (total pipe 
segments) * (total time steps). Excludes all 
calculations performed on nodes.  

 
 



 PipeWeb user's guide 

- 49 - 

3.5. Nodes 

Junction flow rate multiplier 
Global multiplier applied to all demands to make total system consumption vary up or 
down by a fixed amount (e.g., 2.0 doubles all demands, 0.5 halves them, and 1.0 
leaves them as is). 

Spray emitter exponent  
Power to which pressure is raised when computing the flow through an emitter 
device. The textbook value for nozzles and sprinklers is 0.5. This may not apply to 
pipe leakage. Consult the discussion of Emitters for more details. Only available for 
the epanet project type. 

Low pressure flow curtailing 
Selects between demand or pressure driven analysis – DDA or PDA, respectively. 
DDA assumes demands are fixed at a given point in time, while PDA assumes 
demands depend on pressure at low pressure levels. The PDA option can be used to 
find a solution when negative pressures are present in a DDA. See Pressure Driven 
Demand for more information. 

Minimum curtail pressure 
In a PDA, as selected by the above-mentioned option, the pressure below which 
demand is assumed to be zero. 

Required curtail pressure 
In a PDA, the pressure required to deliver the full demand. 

Curtail transition exponent 
PDA assumes a pressure demand relation raised to an exponent. Standard value 
is 0.5. 

Transient compliant network 
Select Yes to disable junction properties that are not compatible with the transient 
solver. 
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3.6. Tracing  / Quality  

Tracing model 
Type of liquid tracing/quality parameter to be modeled. Only available if scheduling is 
applied for the hydraulic solver. The options are: 

• None (no tracing), 

• Reacting species (compute chemical concentrations) 

• Residence time (compute liquid age) 

• Source tracking (trace flow from a specific node) 

Unit concentration  
Concentration units used to express concentration. Choices are mg/L or ug/L. Units 
for Age and Trace analyses are fixed at hours and percent, respectively  

Tracing tolerance 
Smallest change in tracing/quality that will cause a new parcel of liquid to be created 
in a pipe. A typical setting might be 0.01 (for species in units mg/L). This tolerance 
parameter determines when the tracing parameter of one parcel of fluid is essentially 
the same as another parcel.  

Source node name 
Name of the node whose flow is being traced. Applies only to source tracing  

Pipe wall reaction order 
Power to which concentration is raised when computing a bulk flow reaction rate. 
Choices are FIRST (1) for first-order reactions or ZERO (0) for constant rate 
reactions. If no global or pipe-specific wall reaction coefficients are assigned then this 
option is ignored. 

Pipe bulk reaction order 
Power to which concentration is raised when computing a bulk flow reaction rate. 
Use 1 for first-order reactions, 2 for second-order reactions, etc. Use any negative 
number for Michaelis-Menton kinetics. If no global or pipe-specific bulk reaction 
coefficients are assigned then this option is ignored. 

Tank bulk reaction order 
Power to which concentration is raised when computing a bulk flow reaction rate. 
Use 1 for first-order reactions, 2 for second-order reactions, etc. Use any negative 
number for Michaelis-Menton kinetics. If no global or pipe-specific bulk reaction 
coefficients are assigned then this option is ignored. 

Global wall rate constant 
Wall reaction rate coefficient Kw assigned to all pipes. Can be overridden by editing 
this property for specific pipes. Use a positive number for growth, a negative number 
for decay, or 0 if no wall reaction occurs. Units are ft/day (US) or m/day (SI) for first-
order reactions and mass/sq ft/day (US) or mass/sq m/day (SI) for zero- order 
reactions. 

Global bulk rate constant 
Default bulk reaction rate coefficient Kb assigned to all pipes. This global coefficient 
can be overridden by editing this property for specific pipes. Use a positive number 
for growth, a negative number for decay, or 0 if no bulk reaction occurs. Units are 
concentration raised to the (1 - n) power divided by days, where n is the bulk reaction 
order. 
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Diffusivity 
Molecular diffusivity of the chemical being modeled. Only used when modeling mass 
transfer for pipe wall reactions. Set to zero to ignore mass transfer effects. 

Concentration limit 
Maximum concentration that a substance can grow to or minimum value it can decay 
to. Bulk reaction rates will be proportional to the difference between the current 
concentration and this value. See discussion of Bulk Reactions in section Liquid 
Quality Simulation Model for more details. Set to zero if not applicable. 
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3.7. Controls 

Control of the hydraulic system is configured in the controls tab. The section Control 
system provides further details on how to use define in a model. 
 
Controls specification method 
Selects the method for definition of controls in the hydraulic model. The options are: 
 

• Menu-guided Simple controls depending on a single condition in the 
network 

• Scripted Rule-based controls depending on multiple simultaneously 
occurring conditions. 

 

3.7.1. Menu guided controls 

Simple controls can be added or removed using the contextual menu which appears 
upon a right mouse button click on the control items list. The content of the last 
column can be edited after clicking on the corresponding cell. The other columns 
have a drop-down menu which permits selection of the applied value. 
 

 

3.7.2. Rule based controls 

Rule-based controls can be specified by the rule-based control composer, which is a 
basic text editor, with some additional features that assist coding. Note that a rule 
definition must be start with the keyword RULE followed by a sequence number.  
 

 
 

Automatic code completion 
This feature automatically fills out method names and object names while editing 
scripts. A list of selectable phrases appears in a popup list on the text area when the 
Tab key or Ctrl+Space key is pressed. The list contains method or object names 
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which represent an appropriate continuation of the text preceding the caret position 
on the text area. The desired item in the list can be selected with the navigation keys 
on the keyboard. Pressing the Tab key, spacebar or the Enter key will complete the 
text at the caret position with the selected item in the pop-up list. Pressing the Esc 
key closes the list without making any changes to the script code. 

Comment button 
The comment button on the top right of the frame converts selected code lines into 
comments by inserting a hyphen character at the beginning of the line. If all selected 
lines start with a hyphen character the hyphens are removed in order to convert the 
comments back into script code. 

Find and replace 
A set of text search controls appears above the text area upon pressing the Ctrl-F 
shortcut key combination. A click on the Find button, which is located at the right of 
the text field, will highlight all matching occurrences in the script. Additional Ctrl F 
keystrokes will loop through the search matches by selecting the search matches. 
Holding down the Shift key as well reverses the loop direction. The items in the 
Search options contextual menu offer several options for the search method 
applied. The Close button to the left of the search text box clears the search and 
hides the text search controls.  
 
The command Replace in the contextual menu of the Search text field or pressing 
the Ctrl R shortcut key combination exposes an additional text field and push button 
underneath the Search text field. The push button performs a replacement of the 
selected search text match by the text specified in the Replace text field. The 
command Replace all in the contextual menu of the Replace text field replaces all 
search matches by the replacement text.  
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3.8. Reporting 

Time display format 
Selects the format for time display. The options include:  
HHH  number of completed hours since simulation start 
ddd  number of completed days since simulation start 
HH:MM:SS 24-hour clock time display  
.# fractional hour or day time  

Contour map scale min. / max. 
Specifies the extent of the color contour map display scale range clipping. 

Contour map log scale 
Check to activate the log scale option for color contour map display. 

Contour map clip to range 
Check to hide color contours with values outside the above-mentioned scale min. / 
max. extent.  

Contour legend annotation 
Check to activate indication of the color contour map legend scale range values. 

Contour legend location 
Selects the location of the contour map color legend. 

Contour legend size 
Selects the size of the contour map color legend. 

Prohibit chart data compression 
Check to prevent chart data compression for smoother chart curves on the results 
tab for transient simulations with high wave oscillation counts or scheduled 
simulations with high duration times.  
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4. Results 

The configuration window provides access to simulation results and many other 
elements of the project. The window is opened by the Configuration menu on the 
Tools menu or by double-clicking the viewport.  
 
The category bar at the top of window selects the main category for which properties 
are displayed. Selecting a category displays the corresponding console with all 
relevant control items.  
 
The Results console provides access to results of both hydraulic simulation and 
transient analysis.  
 

 
 
The tabs on the Presentation tab strip located below the category bar at the top of 
window select the configuration of the data presentation as follows: 

• Table Displays hydraulic simulation node or link results at a 
specified point in time in a table. 

• Columns Displays hydraulic simulation node or link results at a 
specified point in time in a column diagram. 

• Time series Displays hydraulic simulation node or link results as a 
function of time in a chart. 

• Grade line Displays hydraulic head results along a flow trajectory at 
a specified point in time in a chart. 

• Transient data Displays transient analysis results either as a function of 
time or along a flow trajectory in a chart. 

 



 PipeWeb user's guide 

- 56 - 

4.1. Results display control 

Both the results table and the various chart elements may be configured using the 
contextual menu, which appears upon a right mouse click on the chart or table. The 
available commands are: 
 

Column display  

Selects the below-mentioned Hydraulic parameters for display in a column in the 
results Table.  

Place chart on the viewport 
Places the chart as configured on the Viewport. Charts placed in the viewport are 
updated when the results are updated by a new solver run. In addition, they can be 
resized and styled using Chart Configuration. 

Reset Y-scale range 
Rematches the Y-scale range to the span of the y-values data set. This command 
can be helpful after changing the schedule time selection or the Transient parameter 
control bar value for a chart. For these actions the scale range is not automatically 
reduced if the Y-data range is contracting, but this adjustment can still be imposed by 
this command. 

Show curves for range min/max values 
Forces the display of separate curves for minimum and maximum values in time for 
Transient data charts. Only effective along a continuous piping trajectory and if a 
single transient data parameter is selected. The min/max value curves are plotted in 
the same formatting as the transient parameter curve, but with a smaller line 
thickness. 

Legend adjacent 
Toggles between legend placement inside the chart plot area or adjacent to the chart 
at the top right. 

Hydraulic parameters 
The hydraulic solver results can be displayed for the following parameters: 

• Total head Total head at a node [m or ft]  

• Pressure Stagnation pressure (gauge) at a node [Selected 
pressure unit]  

• Flow rate Flow rate [Selected flow rate unit]. (epanet project type: 
< 0 if entering the system; Standard project type: < 0 if 
leaving system).  

• Curtailing  Percent curtailing applied at a junction node [%] 

• Tank level  Liquid level in a tank node [m or ft]  

• Trace  Depends on the selection for Tracing model. 
Concentration of tracer compound [mg/L or μg/L] or fluid 
residence time [hrs], or % fluid from source. 

• Elevation  Elevation of a node with respect to a fixed model datum 
[m or ft]  

• Pipe length Length of a pipe link [m or ft]  

• Velocity  Flow velocity in a pipe, valve or obstruction [m/sec or 
ft/sec]  

• Pressure loss Pressure differential across a pump, pipe, valve or 
obstruction [Selected pressure differential unit] 

• Dissipation Energy dissipation in a pump, pipe, valve or obstruction 
[kW] 
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• Loss coeff.  Resistance coefficient 2·g·ΔH / (v2) of a pipe, valve or 

obstruction [-] 

• Pipe diam. Pipe diameter [m or ft]  

• Reynolds Pipe Reynolds number [-] 

• Spec. dissip.  Pipe energy dissipation per unit length [kW/km or 
kW/mile] 

Schedule times list  
If scheduling is applied for the hydraulic solver, the schedule time point for hydraulic 
data display can be selected in the Scheduling times list. This list is only available for 
Columns and Grade line charts and on the Table tab, if more than one link and node 
objects are selected in the viewport. It is located at the left side of the Simulation 
results frame.  
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4.1. Results display elements 

Depending on the selected tab on the Presentation tab strip located below the 
category bar at the top of window the data displayed on the chart area is one of the 
items given below. The chart properties may be adjusted using contextual menu 
commands as discussed in the Results display control section. If scheduling is 
applied for the hydraulic solver, data displayed for some chart types also depends on 
the selected row in the Scheduling times list.  

Table 
The Table tab presents a table of hydraulic simulation results of all objects selected 
for various hydraulic parameters on the datasheet at a selected point in time. The 
Parameter columns displayed can be determined by the contextual menu which 
appears upon a right-click on the table with the mouse. 

Columns 
The Columns tab presents a column chart of hydraulic simulation results of all 
objects selected on the viewport for one or more hydraulic parameters. The displayed 
parameters can be selected from the set of checkboxes above the chart. The time 
point for data display can be selected in the times list located to the left of the 
columns chart. A Column results chart can be placed on the Viewport using the right-
button contextual menu of the chart.  

Time series 
The Time series tab presents a chart of hydraulic simulation results of all objects 
selected on the viewport for one or more hydraulic parameters as a function of time. 
The displayed parameters can be selected from the set of checkboxes above the 
chart. A Time series results chart can be placed on the Viewport using the right-
button contextual menu of the chart.  

Grade line  
The Grade line tab presents a line chart of hydraulic simulation results of a chain of 
links selected on the viewport forming a continuous flow trajectory, for one or more 
hydraulic head parameters. The set of checkboxes above the chart allows selection 
of the plotted parameters. The hydraulic head parameter values [m or ft] that can be 
displayed are: 

• Total head Total head: Sum of elevation and static pressure 
head and velocity head  

• Elevation Elevation head  

• Static head Static pressure head  

• Velocity head Velocity head: ρ·v2/(2·g)  

• Stagnation head Sum of static pressure head and velocity head  

• Hydraulic head Sum of elevation and static pressure head  
 
The elevation parameter varies linearly with pipe length from the source node 
elevation to the target node elevation. The outflow of liquid into a tank or reservoir 
results into complete dissipation of the velocity head and of any elevation head of the 
tank inlet nozzle above the liquid level (see headspace height). The corresponding 
head loss is indicated by a vertical segment of the total head grade line at the node 
location.  
 
The time points list located to the left of the columns chart selects the time for data 
display. A grade line chart can be placed on the Viewport using the right-button 
contextual menu of the chart. No data is displayed if the selected links chain does not 
form a continuous flow path. 
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Transient data 
The Transient data tab presents a line chart of hydraulic simulation results of all 
objects selected on the viewport, for one or more transient parameters. The 
displayed parameters can be selected from the set of checkboxes above the chart. 
The transient analysis parameter values that can be displayed are: 

• Pressure Static pressure at a pipe location [Selected pressure unit]  

• Velocity Flow velocity at a pipe location [m/sec or ft/sec] 

• Vapor fraction Vapor mass fraction at a pipe location [-] 

• Pipe force Unbalanced force exerted on a pipe or pipe segments 
divided by elbows [kN] 

• Node flow rate  Node flow rate as a function of time [Selected flow rate 
unit]. For reservoir and junction nodes this parameter 
represents the flow leaving or entering the system either 
in steady state or as mitigator action. For other node 
types it represents the flow rate through the node. 

• Liquid level Liquid level of a junction node of mitigator type Gas 
accumulator or Standpipe as a function of time [m or ft]  

• Modulation Modulation action as a function of time [Dimensionless]. 
The parameter is either the modulated valve loss 
coefficient, or ratio of the actual flow coefficient Kv/Cv to 
the maximum value of a modulated closing valve or a 
modulating relief valve, or the actual speed factor of a 
tripping or modulated pump.  

 
A set of controls, depicted below, located underneath the chart, govern the transient 
data display properties. A chart type switch button is located at the left. The large 
parameter control bar in the middle can be adjusted by mouse dragging or by the 
small step buttons on either side of the bar. The switch button toggles between time 
and location charts. A time chart plots a transient results variable as a function of 
time, with the location being determined by the parameter control bar. Alternatively, a 
location chart plots a transient variable as a function of pipe location, with time fixed 
by the parameter control bar. The latter option indicates the node locations in the 
parameter control bar and is available only if the selected links chain forms a 
continuous flow path. The active parameter plot option is indicated by the color of the 
parameter control bar and the chart x-axis title. 
 

 
 
Holding down the left mouse button on one of the two arrow buttons for a short time 
activates an animation with continuously proceeding chart parameter value. The 
animation is stopped by clicking on any of the transient result controls. 
 
A Transient data results chart can be placed on the Viewport using the right-button 
contextual menu of the chart. This menu also allows to enable display of min/max 
value curves together with a curve for a parameter along a continuous piping path  
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5. Hydraulic and transient solvers 

This section focuses on the architecture of the hydraulic solver and the transient 
solver. The text of sections 5.1 through 5.5 has been adopted with minor changes 
from https://github.com/USEPA/epanet-manual. 

https://github.com/USEPA/epanet-manual
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5.1. EPANET Physical Components 

EPANET models a liquid distribution system as a collection of links connected to 
nodes. The links represent pipes, pumps, and control valves. The nodes represent 
junctions, tanks, and reservoirs. Fig. 5.1 below illustrates how these objects can be 
connected to one another to form a network. 
 

 

Fig. 5.1 Physical components in a liquid distribution system. 

5.1.1. Junctions 

Junctions are points in the network where links join together and where liquid enters 
or leaves the network. The basic input data required for junctions are: 
 

• Elevation above some reference (usually mean sea level) 
• Liquid demand (rate of withdrawal from the network) 
• Initial liquid quality 

 
The output results computed for junctions at all time periods of a simulation are: 
 

• Hydraulic head (internal energy per unit weight of fluid) 
• Pressure (gauge) 
• Liquid quality 

 
Junctions can also: 
 

• Have their demand vary with time 
• Have multiple categories of demands assigned to them 
• Have negative demands indicating that liquid is entering the 

network 
• Have pressure driven demand 
• Be liquid quality sources where constituents enter the network 
• Contain emitters (or sprinklers) which make the outflow rate 

depend on the pressure 

5.1.2. Reservoirs 

Reservoirs are nodes that represent an infinite external source or sink of liquid to the 
network. They are used to model such things as lakes, rivers, groundwater aquifers, 
and tie-ins to other systems. Reservoirs can also serve as liquid quality source 
points. 
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The primary input properties for a reservoir are its hydraulic head (equal to the liquid 
surface elevation if the reservoir is not under pressure) and its initial quality for liquid 
quality analysis. 

Because a reservoir is a boundary point to a network, its head and liquid quality 
cannot be affected by what happens within the network. Therefore it has no 
computed output properties. However its head can be made to vary with time by 
assigning a time pattern to it (see Time Patterns below). 

5.1.3. Tanks 

Tanks are nodes with storage capacity, where the volume of stored liquid can vary 
with time during a simulation. The primary input properties for tanks are: 
 

• Bottom elevation (where liquid level is zero) 
• Diameter (or shape if non-cylindrical ) 
• Initial, minimum and maximum liquid levels 
• Initial liquid quality 

 
The principal outputs computed over time are: 
 

• Hydraulic head (liquid surface elevation) 
• Liquid quality 

 
Tanks are required to operate within their minimum and maximum levels. EPANET 
stops outflow if a tank is at its minimum level and stops inflow if it is at its maximum 
level. Tanks can also serve as liquid quality source points. 

5.1.4. Emitters 

Emitters are devices associated with junctions that model the flow through a nozzle 
or orifice that discharges to the atmosphere. The flow rate through the emitter varies 
as a function of the pressure available at the node: 
 
q = C p^γ 

 

where q = flow rate, p = gauge pressure, C = discharge coefficient, and γ = pressure 
exponent. For nozzles and sprinkler heads γ equals 0.5 and the manufacturer usually 
provides the value of the discharge coefficient in units of gpm/psi 0.5 (stated as the 
flow through the device at a 1 psi pressure drop). 

Emitters are used to model flow through sprinkler systems and irrigation networks. 
They can also be used to simulate leakage in a pipe connected to the junction (if a 
discharge coefficient and pressure exponent for the leaking crack or joint can be 
estimated) or compute a fire flow at the junction (the flow available at some minimum 
residual pressure). In the latter case one would use a very high value of the 
discharge coefficient (e.g., 100 times the maximum flow expected) and modify the 
junction’s elevation to include the equivalent head of the pressure target. EPANET 
treats emitters as a property of a junction and not as a separate network component. 

Note: The pressure-flow relation at a junction defined by an emitter should not be 
confused with the pressure-demand relation when performing a pressure driven 
analysis (PDA). See Pressure Driven Demand for more information. 
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5.1.5. Pipes 

Pipes are links that convey liquid from one point in the network to another. EPANET 
assumes that all pipes are full at all times. Flow direction is from the end at higher 
hydraulic head (internal energy per weight of liquid) to that at lower head. The 
principal hydraulic input parameters for pipes are: 
 

• Start and end nodes 
• Diameter 
• Length 
• Roughness coefficient (for determining headloss) 
• Status (open, closed, or contains a check valve) 

 
The status parameter allows pipes to implicitly contain shutoff (gate) valves and 
check (non-return) valves (which allow flow in only one direction). 
The liquid quality inputs for pipes consist of: 
 

• Bulk reaction coefficient 
• Wall reaction coefficient 

 
These coefficients are explained more thoroughly in section Liquid Quality Simulation 
Model. 
 
Computed outputs for pipes include: 
 

• Flow rate 
• Velocity 
• Headloss 
• Darcy-Weisbach friction factor 
• Average reaction rate (over the pipe length) 
• Average liquid quality (over the pipe length) 

 
The hydraulic head lost by liquid flowing in a pipe due to friction with the pipe walls 
can be computed using one of three different formulas: 
 

• Hazen-Williams formula 
• Darcy-Weisbach formula 
• Chezy-Manning formula 

 
The Hazen-Williams formula is the most commonly used headloss formula in the US. 
It cannot be used for liquids other than liquid and was originally developed for 
turbulent flow only. The Darcy-Weisbach formula is the most theoretically correct. It 
applies over all flow regimes and to all liquids. The Chezy-Manning formula is more 
commonly used for open channel flow. 
Each formula uses the following equation to compute headloss between the start and 
end node of the pipe: 
hL = A q^B 

where ℎL = headloss (Unit: Length), q = flow rate (Unit: Volume/Time), A = resistance 

coefficient, and B = flow exponent. Table 5.1 lists expressions for the resistance 
coefficient and values for the flow exponent for each of the formulas. Each formula 
uses a different pipe roughness coefficient that must be determined 
empirically. Table 5.2 lists general ranges of these coefficients for different types of 
new pipe materials. Be aware that a pipe’s roughness coefficient can change 
considerably with age. 



 PipeWeb user's guide 

- 64 - 

With the Darcy-Weisbach formula EPANET uses different methods to compute the 
friction factor f depending on the flow regime: 

• The Hagen–Poiseuille formula is used for laminar flow (Re < 
2,000). 

• The Swamee and Jain approximation to the Colebrook-White 
equation is used for fully turbulent flow (Re > 4,000). 

• A cubic interpolation from the Moody Diagram is used for 
transitional flow (2,000 < Re < 4,000). 

 
Consult the text in Analysis Algorithms for the actual equations used. 
 

TABLE 5.1 PIPE HEADLOSS FORMULAS FOR FULL FLOW (FOR HEADLOSS IN 
FEET AND FLOW RATE IN CFS) 

Formula Resistance Coefficient (A) Flow Exponent (B) 

Hazen-Williams 4.727 C−1.852 d−4.871 L 1.852 

Darcy-Weisbach 0.0252 f(ε,d,q) d−5 L 2 

Chezy-Manning 4.66 n2 d−5.33 L 2 

Notes: 

C = Hazen-Williams roughness coefficient 

ε = Darcy-Weisbach roughness coefficient (ft) 

f = friction factor (dependent on ε, d and q) 

n = Manning roughness coefficient 

d = pipe diameter (ft) 

L = pipe length (ft) 

q = flow rate (cfs) 

 

Table 5.2 Roughness Coefficients for New Pipe 

Material Hazen-

Williams C 

(unitless) 

Darcy-Weisbach ε 

(ft x 10−3) 

Manning’s n 

(unitless) 
Cast Iron 130 – 140 0.85 0.012 – 0.015 
Concrete or Concrete 
Lined 

120 – 140 1.0 – 10 0.012 – 0.017 

Galvanized Iron 120 0.5 0.015 – 0.017 
Plastic 140 – 150 0.005 0.011 – 0.015 
Steel 140 – 150 0.15 0.015 – 0.017 
Vitrified Clay 110 

 
0.013 – 0.015 

Pipes can be set open or closed at preset times or when specific conditions exist, 
such as when tank levels fall below or above certain set points, or when nodal 
pressures fall below or above certain values. See the discussion of Controls in 
Section 3.2. 

Minor Losses 
Minor head losses (also called local losses) are caused by the added turbulence that 
occurs at bends and fittings. The importance of including such losses depends on the 
layout of the network and the degree of accuracy required. They can be accounted 

https://epanet22.readthedocs.io/_/downloads/en/latest/pdf/#page=121&zoom=100,66,96
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for by assigning the pipe a minor loss coefficient. The minor headloss becomes the 
product of this coefficient and the velocity head of the pipe, i.e., 
 

hL = K·v2/ (2·g) 
 

where K = minor loss coefficient, v = flow velocity (Unit: Length/Time), and g = 
acceleration of gravity (Unit: Length/Time2) 
 
Pumps are links that impart energy to a fluid thereby raising its hydraulic head. The 
principal input parameters for a pump are its start and end nodes and its pump curve 
(the combination of heads and flows that the pump can produce). In lieu of a pump 
curve, the pump could be represented as a constant energy device, one that supplies 
a constant amount of energy (horsepower or kilowatts) to the fluid for all 
combinations of flow and head. 
 
The principal output parameters are flow and head gain. Flow through a pump is 
unidirectional and EPANET will not allow a pump to operate outside the range of its 
pump curve. 
 
Variable speed pumps can also be considered by specifying that their speed setting 
be changed under these same types of conditions. By definition, the original pump 
curve supplied to the program has a relative speed setting of 1. If the pump speed 
doubles, then the relative setting would be 2; if run at half speed, the relative setting 
is 0.5 and so on. Changing the pump speed shifts the position and shape of the 
pump curve (see the section on Pump Curves below). 
 
As with pipes, pumps can be turned on and off at preset times or when certain 
conditions exist in the network. A pump’s operation can also be described by 
assigning it a time pattern of relative speed settings. Each pump can be assigned an 
efficiency curve. If these a global pump efficiency value will be used. 
 
Flow through a pump is unidirectional. If system conditions require more head than 
the pump can produce, EPANET shuts the pump off. If more than the maximum flow 
is required, EPANET extrapolates the pump curve to the required flow, even if this 
produces a negative head. In both cases a warning message will be issued. 

5.1.6. Valves 

Valves are links that limit the pressure or flow at a specific point in the network. Their 
principal input parameters include: 
 

• Start and end nodes 
• Diameter 
• Setting 
• Status 

 
The computed outputs for a valve are flow rate and headloss. The different types of 
control valves included in EPANET are: 
 

• Pressure Reducing Valve (PRV) 
• Pressure Sustaining Valve (PSV) 
• Pressure Breaker Valve (PBV) 
• Flow Control Valve (FCV) 
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The valves types included in EPANET that correspond with the PipeWeb object type 
"Restrictor" are: 
 

• Throttle Control Valve (TCV) 
• General Purpose Valve (GPV) 

 
PRVs limit the pressure at a point in the pipe network. EPANET computes in which of 
three different states a PRV can be in: 
 

• Partially opened (i.e., active) to achieve its pressure setting on 
its downstream side when the upstream pressure is above the 
setting 

• Fully open if the upstream pressure is below the setting 
• Closed if the pressure on the downstream side exceeds that 

on the upstream side (i.e., reverse flow is not allowed) 
 
PSVs maintain a set pressure at a specific point in the pipe network. EPANET 
computes in which of three different states a PSV can be in: 
 

• Partially opened (i.e., active) to maintain its pressure setting on 
its upstream side when the downstream pressure is below this 
value 

• Fully open if the downstream pressure is above the setting 
• Closed if the pressure on the downstream side exceeds that 

on the upstream side (i.e., reverse flow is not allowed) 
 
PBVs force a specified pressure loss to occur across the valve. Flow through the 
valve can be in either direction. PBV’s are not true physical devices but can be used 
to model situations where a particular pressure drop is known to exist. Only available 
for the epanet project type. 
 
FCVs limit the flow to a specified amount. The program produces a warning message 
if this flow cannot be maintained without having to add additional head at the valve 
(i.e., the flow cannot be maintained even with the valve fully open). 
Restrictors simulate a partially closed valve by adjusting the minor head loss 
coefficient of the valve. A relationship between the degree to which a valve is closed 
and the resulting head loss coefficient is usually available from the valve 
manufacturer. The user may supply a special flow - head loss relationship curve 
instead of a fixed minor loss coefficient. These curves can be used to model turbines, 
well drawdown or reduced-flow backflow prevention valves. 
 
Shutoff valves and check (non-return) valves, which completely open or close pipes, 
are not considered as separate valve links but are instead included as a property of 
the pipe in which they are placed. As an exception, for the RND PipeWeb standard 
project type, check valves are specified as Restrictor option. 
 
Each type of valve has a different type of setting parameter that describes its 
operating point (pressure for PRVs, PSVs, and PBVs; flow for FCVs;  
Valves can have their control status overridden by specifying they be either 
completely open or completely closed. A valve’s status and its setting can be 
changed during the simulation by using control statements. 
Because of the ways in which valves are modeled the following rules apply when 
adding valves to a network: 
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• A PRV, PSV or FCV cannot be directly connected to a reservoir or 
tank (use a length of pipe to separate the two) 

• PRVs cannot share the same downstream node or be linked in series 
• Two PSVs cannot share the same upstream node or be linked in 

series 
• A PSV cannot be connected to the downstream node of a PRV 
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5.2.  Non-Physical Components 

In addition to physical components, EPANET employs three types of informational 
objects – curves, patterns, and controls - that describe the behavior and operational 
aspects of a distribution system. 

5.2.1. Curves 

Curves are objects that contain data pairs representing a relationship between two 
quantities. Two or more objects can share the same curve. An EPANET model can 
utilize the following types of curves: 
 

• Pump Curve 

• Efficiency Curve 

• Volume Curve 

• Head Loss Curve Pump Curve 

• Valve characteristic curve (Not available for the epanet project type) 
  

Pump Curve 
A Pump Curve represents the relationship between the head and flow rate that a 
pump can deliver at its nominal speed setting. Head is the head gain imparted to the 
liquid by the pump and is plotted on the vertical (Y) axis of the curve in feet (meters). 
Flow rate is plotted on the horizontal (X) axis in flow units. A valid pump curve must 
have decreasing head with increasing flow. 
EPANET will use a different shape of pump curve depending on the number of points 
supplied. 
 

Single-Point Pump Curve – A single-point pump curve is defined by a single 

head-flow combination that represents a pump’s desired operating point. EPANET 
adds two more points to the curve by assuming a shutoff head at zero flow equal to 
133% of the design head and a maximum flow at zero head equal to twice the design 
flow. It then treats the curve as a three-point curve. Fig. 5.2 shows an example of a 
single-point pump curve. 
 

 
Fig. 5.2 Single-point pump curve. 
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Three-Point Pump Curve – A three-point pump curve is defined by three 

operating points: a Low Flow point (flow and head at low or zero flow condition), a 
Design Flow point (flow and head at desired operating point), and a Maximum Flow 
point (flow and head at maximum flow). EPANET tries to fit a continuous function of 
the form 

hG = A - B • q^C 
 

through the three points to define the entire pump curve. In this function, hG = head 
gain, q = flow rate, and A, B and C are constants. Fig. 5.3 shows an example of a 
three-point pump curve. 

 

 
 

Fig. 5.3 Three-point pump curve. 
 

Multi-Point Pump Curve – A multi-point pump curve is defined by providing 

either a pair of head-flow points or four or more such points. EPANET creates a 
complete curve by connecting the points with straight-line segments. Fig. 3.4 shows 
an example of a multi-point pump curve. 
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Fig. 5.4 Multi-point pump curve. 

 
 
For variable speed pumps, the pump curve shifts as the speed changes. The 
relationships between flow (Q) and head (H) at speeds N1 and N2 are 
 

Q1/Q2 = N1/N2 
and 

H1/H2 = (N1/N2)2 
 
Fig. 11.5 shows an example of a variable-speed pump curve. 
 

 
Fig. 5.5 Variable-speed pump curve. 

 

Efficiency Curve 
An Efficiency Curve determines pump efficiency (Y in percent) as a function of pump 
flow rate (X in flow units). An example efficiency curve is shown in Fig. 3.6. Efficiency 
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should represent wire-to-liquid efficiency that takes into account mechanical losses in 
the pump itself as well as electrical losses in the pump’s motor. The curve is used 
only for energy calculations. If not supplied for a specific pump then a fixed global 
pump efficiency will be used. 
 

 
Fig. 5.6 Pump efficiency curve 

 

Volume Curve 
A Volume Curve determines how storage tank volume (Y in cubic feet or cubic 
meters) varies as a function of liquid level (X in feet or meters). It is used when it is 
necessary to accurately represent tanks whose cross-sectional area varies with 
height. The lower and upper liquid levels supplied for the curve must contain the 
lower and upper levels between which the tank operates. An example of a tank 
volume curve is given in Fig. 3.7. 
 

 
Fig. 5.7 Tank volume curve 

 

Headloss Curve 
A Headloss Curve is used to described the headloss (Y in feet or meters) through a 
General-Purpose Valve (GPV) as a function of flow rate (X in flow units). It provides 
the capability to model devices and situations with unique headloss-flow 
relationships, such as reduced flow - backflow prevention valves, turbines, and well 
draw-down behavior. 
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5.2.2. Time Patterns 

A Time Pattern is a collection of multipliers that can be applied to a quantity to allow it 
to vary over time. Nodal demands, reservoir heads, pump schedules, and liquid 
quality source inputs can all have time patterns associated with them. The time 

interval used in all patterns is a fixed value, set with the project’s Time Options in the 

Scheduling tab of the Model properties console. Within this interval a quantity 

remains at a constant level, equal to the product of its nominal value and the 
pattern’s multiplier for that time period. Although all time patterns must utilize the 
same time interval, each can have a different number of periods. When the 
simulation time span exceeds the number of periods in a pattern, the pattern wraps 
around to its first period again. 
 
As an example of how time patterns work, consider a junction node with an average 
demand of 10 GPM. Assume that the time pattern interval has been set to 4 hours 
and a pattern with the following multipliers has been specified for demand at this 
node as in the table below: 
 

Table 5.4 Example Time Pattern Multipliers 
Period 1 2 3 4 5 6 

Multiplier 0.5 0.8 1.0 1.2 0.9 0.7 

 
Then during the simulation the actual demand exerted at this node will be as follows: 
 

Table 5.5 Actual Demands at Node 
Hours 0-4 4-8 8-12 12-16 16-20 20-24 24-28 

Demand 5 8 10 12 9 7 5 

5.2.3. Control system 

Controls are statements that determine how the network is operated over time. They 
specify the status of selected links as a function of time, tank liquid levels, and 
pressures at select points within the network. There are two categories of controls 
that can be used: 
 

• Simple Controls 
• Rule-Based Controls Simple Controls 

 
Simple Controls 
Simple controls change the status or setting of a link based on: 
 

• The liquid level in a tank 
• The pressure at a junction 
• The time into the simulation 
• The time of day 

 
They are statements expressed in one of the following three formats: 
 

LINK x status IF NODE y ABOVE/BELOW z 

LINK x status AT TIME t 
  

LINK  x status AT CLOCKTIME c AM/PM 
 

 
where: | x = a link ID label, | status = OPEN or CLOSED, a pump speed setting, or a 
control valve setting, | y = a node ID label, | z = a pressure for a junction or a liquid 
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level for a tank, | t = a time since the start of the simulation (decimal hours or 
hours:minutes), | c = a 24-hour clock time. 
Some examples of simple controls are (Table 5.6): 
 

Table 5.6 Examples of Simple Controls 
Control Statement Meaning 

LINK 12 CLOSED IF NODE 23 ABOVE 20 (Close Link 12 when the level in 
Tank 23 exceeds 20 ft.) 

LINK 12 OPEN IF NODE 130 BELOW 30 (Open Link 12 if the pressure at 
Node 130 drops below 30 psi) 
drops below 30 psi) 

LINK 12 1.5 AT TIME 16 (Set the relative speed of pump 12 
to 1.5 at 16 hours into the 
simulation) 

LINK 12 CLOSED AT CLOCKTIME 10 AM 
LINK 12 OPEN AT CLOCKTIME 8 PM 

(Link 12 is repeatedly closed at 10 
AM and opened at 8 PM 
throughout the simulation) 

 
There is no limit on the number of simple control statements that can be used. 
 
Note: Level controls are stated in terms of the height of liquid above the tank bottom, 
not the elevation (total head) of the liquid surface. 
Note: Using a pair of pressure controls to open and close a link can cause the 
system to become unstable if the pressure settings are too close to one another. In 
this case using a pair of Rule-Based controls might provide more stability. 
 
Rule-Based Controls 
Rule-Based Controls allow link status and settings to be based on a combination of 
conditions that might exist in the network after an initial hydraulic state of the system 
is computed. Here are several examples of Rule-Based Controls: 
 
Example 1: 
This set of rules shuts down a pump and opens a by-pass pipe when the level in a 
tank exceeds a certain value and does the opposite when the level is below another 
value. 
 
RULE 1 

IF TANK 1 LEVEL ABOVE 19.1 

THEN PUMP 335 STATUS IS CLOSED 

AND PIPE 330 STATUS IS OPEN 

 

RULE 2 

IF TANK 1 LEVEL BELOW 17.1 

THEN PUMP 335 STATUS IS OPEN 

AND PIPE 330 STATUS IS CLOSED 

 

Example 2: 
These rules change the tank level at which a pump turns on depending on the time of 
day. 
 
RULE 3 

IF SYSTEM CLOCKTIME >= 8 AM 

AND SYSTEM CLOCKTIME < 6 PM 

AND TANK 1 LEVEL BELOW 12 

THEN PUMP 335 STATUS IS OPEN 
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RULE 4 

IF SYSTEM CLOCKTIME >= 6 PM 

OR SYSTEM CLOCKTIME < 8 AM 

AND TANK 1 LEVEL BELOW 14 

THEN PUMP 335 STATUS IS OPEN 

 

A description of the formats used with Rule-Based controls can be found in section 
Rule-Based Controls syntax. 
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5.3.  Hydraulic Simulation Model 

EPANET’s hydraulic simulation model computes junction heads and link flows for a 
fixed set of reservoir levels, tank levels, and liquid demands over a succession of 
points in time. From one time step to the next reservoir levels and junction demands 
are updated according to their prescribed time patterns while tank levels are updated 
using the current flow solution. The solution for heads and flows at a particular point 
in time involves solving simultaneously the conservation of flow equation for each 
junction and the headloss relationship across each link in the network. This process, 
known as “hydraulically balancing” the network, requires using an iterative technique 
to solve the nonlinear equations involved. EPANET employs the “Gradient Algorithm” 
for this purpose. Consult chapter Analysis Algorithms for details. 

5.3.1. Pressure driven demand 

EPANET may issue a warning message when it encounters negative pressures at 
junctions that have positive demands. This usually indicates that there is some 
problem with the way the network has been designed or operated. Negative 
pressures can occur for example when portions of the network can only receive fluid 
through links that have been closed off. As a resolution, a pressure driven analysis 
(PDA) can be performed to determine a hydraulic solution assuming a pressure-
demand relationship at junctions. The hydraulic solution found will have curtailed or 
zero flow rates at low pressure and negative pressures will be largely eliminated. 

Only available for the epanet project type. Consult chapter Analysis Algorithms for 
details.  
 
The hydraulic time step used for extended period simulation (EPS) can be set by the 
user. A typical value is 1 hour. Shorter time steps than normal will occur 
automatically whenever one of the following events occurs: 
 

• The next output reporting time period occurs 
• The next time pattern period occurs 
• A tank becomes empty or full 
• A simple control or rule-based control is activated 

https://epanet22.readthedocs.io/_/downloads/en/latest/pdf/#page=121&zoom=100,66,96
https://epanet22.readthedocs.io/_/downloads/en/latest/pdf/#page=121&zoom=100,66,96
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5.4. Liquid Quality Simulation Model 

5.4.1. Basic Transport 

EPANET’s liquid quality simulator uses a Lagrangian time-based approach to track 
the fate of discrete parcels of liquid as they move along pipes and mix together at 
junctions between fixed-length time steps. These liquid quality time steps are 
typically much shorter than the hydraulic time step (e.g., minutes rather than hours) 
to accommodate the short times of travel that can occur within pipes. 

The method tracks the concentration and size of a series of non-overlapping 
segments of liquid that fills each link of the network. As time progresses, the size of 
the most upstream segment in a link increases as liquid enters the link while an equal 
loss in size of the most downstream segment occurs as liquid leaves the link. The 
size of the segments in between these remains unchanged. 

For each liquid quality time step, the contents of each segment are subjected to 
reaction, a cumulative account is kept of the total mass and flow volume entering 
each node, and the positions of the segments are updated. New node concentrations 
are then calculated, which include the contributions from any external sources. 
Storage tank concentrations are updated depending on the type of mixing model that 
is used (see below). Finally, a new segment will be created at the end of each link 
that receives inflow from a node if the new node quality differs by a user-specified 
tolerance from that of the link’s last segment. 

Initially each pipe in the network consists of a single segment whose quality equals 
the initial quality assigned to the upstream node. Whenever there is a flow reversal in 
a pipe, the pipe’s parcels are re-ordered from front to back. 

5.4.2. Mixing in Storage Tanks 

EPANET can use four different types of models to characterize mixing within storage 
tanks: 

• Ideal (Complete Mixing) 
• Two-Compartment Mixing 
• First-in First-out (FIFO) Plug Flow 
• Last-in First-out (LIFO) Plug Flow 

Different models can be used with different tanks within a network. 

The Complete Mixing model (Fig. 3.8) assumes that all liquid that enters a tank is 
instantaneously and completely mixed with the liquid already in the tank. It is the 
simplest form of mixing behavior to assume, requires no extra parameters to 
describe it, and seems to apply quite well to a large number of facilities that operate 
in fill-and-draw fashion. 

file:///D:/_Projects/Spectra/Flow/Help/epanet-manual-dev/_build/html/3_network_model.html%23fig-complete-mix
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Fig. 3.8 Complete mixing. 

The Two-Compartment Mixing model (Fig. 3.9) divides the available storage volume 
in a tank into two compartments, both of which are assumed completely mixed. The 
inlet/outlet pipes of the tank are assumed to be located in the first compartment. New 
liquid that enters the tank mixes with the liquid in the first compartment. If this 
compartment is full, then it sends its overflow to the second compartment where it 
completely mixes with the liquid already stored there. When liquid leaves the tank, it 
exits from the first compartment, which if full, receives an equivalent amount of liquid 
from the second compartment to make up the difference. The first compartment is 
capable of simulating short-circuiting between inflow and outflow while the second 
compartment can represent dead zones. The user must supply a single parameter, 
which is the fraction of the total tank volume devoted to the first compartment. 

 

Fig. 5.9 Two-compartment mixing. 

The FIFO Plug Flow model (Fig. 3.10) assumes that there is no mixing of liquid at all 
during its residence time in a tank. Liquid parcels move through the tank in a 
segregated fashion where the first parcel to enter is also the first to leave. Physically 
speaking, this model is most appropriate for baffled tanks that operate with 
simultaneous inflow and outflow. There are no additional parameters needed to 
describe this mixing model. 
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Fig. 5.10 Plug flow - FIFO. 

The LIFO Plug Flow model (Fig. 3.11) also assumes that there is no mixing between 
parcels of liquid that enter a tank. However in contrast to FIFO Plug Flow, the liquid 
parcels stack up one on top of another, where liquid enters and leaves the tank on 
the bottom. This type of model might apply to a tall, narrow standpipe with an 
inlet/outlet pipe at the bottom and a low momentum inflow. It requires no additional 
parameters be provided. 

 

Fig. 5.11 Plug flow - LIFO. 

5.4.3. Chemical Reactions 

EPANET can track the growth or decay of a substance by reaction as it travels 
through a distribution system. In order to do this it needs to know the rate at which 
the substance reacts and how this rate might depend on substance concentration. 
Reactions can occur both within the bulk flow and with material along the pipe wall. 
This is illustrated in Fig. 3.12. In this example free chlorine (HOCl) is shown reacting 
with natural organic matter (NOM) in the bulk phase and is also transported through 
a boundary layer at the pipe wall to oxidize iron (Fe) released from pipe wall 
corrosion. Bulk fluid reactions can also occur within tanks. EPANET allows a modeler 
to treat these two reaction zones separately. 
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Fig. 5.12 Reaction zones within a pipe. 

Bulk Reactions 
EPANET models reactions occurring in the bulk flow with n-th order kinetics, where 

the instantaneous rate of reaction (R in mass/volume/time) is assumed to be 

concentration-dependent according to 

R = Kb · Cn 
Here Kb = a bulk reaction rate coefficient, C = reactant concentration (mass/volume), 
and n = a reaction order. Kb has units of concentration raised to the power (1 - n) 
divided by time. It is positive for growth reactions and negative for decay reactions. 
 
EPANET can also consider reactions where a limiting concentration exists on the 
ultimate growth or loss of the substance. In this case the rate expression becomes 

 

where CL = the limiting concentration. Thus there are three parameters (Kb, CL and n) 
that are used to characterize bulk reaction rates. Some special cases of well-known 

kinetic models are provided in Table 5.7 (see Water quality for more examples): 

Table 5.7 Special Cases of Well-known Kinetic Models 

Model Parameters Examples 

First-Order Decay CL = 0, Kb < 0, n = 1 Chlorine 

First-Order Saturation Growth CL > 0, Kb > 0, n = 1  Trihalomethanes 

Zero-Order Kinetics CL = 0, Kb <> 0, n = 0 Liquid Age 

No Reaction CL = 0, Kb = 0 Fluoride Tracer 

The Kb for first-order reactions can be estimated by placing a sample of liquid in a 
series of non-reacting glass bottles and analyzing the contents of each bottle at 

https://epanet22.readthedocs.io/_/downloads/en/latest/pdf/#page=132&zoom=100,66,450
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different points in time. If the reaction is first-order, then plotting the natural log (Ct / 
C0) against time should result in a straight line, where Ct is concentration at time 
t and C0 is concentration at time zero. The parameter Kb would then be estimated as 
the slope of this line. 

Bulk reaction coefficients usually increase with increasing temperature. Running 
multiple bottle tests at different temperatures will provide more accurate assessment 
of how the rate coefficient varies with temperature 

Wall Reactions 
The rate of liquid quality reactions occurring at or near the pipe wall can be 
considered to be dependent on the concentration in the bulk flow by using an 
expression of the form 

R = (A/V) · Kw · Cn 

where Kw = a wall reaction rate coefficient and (A/V) = the surface area per unit 
volume within a pipe (equal to 4 divided by the pipe diameter). The latter term 
converts the mass reacting per unit of wall area to a per unit volume basis. EPANET 
limits the choice of wall reaction order to either 0 or 1, so that the units of Kw are 
either mass/area/time or length/time, respectively. As with Kb, Kw must be supplied to 
the program by the modeler. First-order Kw values can range anywhere from 0 to as 
much as 5 ft/day. 

The variable Kw should be adjusted to account for any mass transfer limitations in 
moving reactants and products between the bulk flow and the wall. EPANET does 
this automatically, basing the adjustment on the molecular diffusivity of the substance 
being modeled and on the flow’s Reynolds number. Refer to the discussion in 
Water quality for details. (Setting the molecular diffusivity to zero will cause mass 
transfer effects to be ignored.) 

The wall reaction coefficient can depend on temperature and can also be correlated 
to pipe age and material. It is well known that as metal pipes age their roughness 
tends to increase due to encrustation and tuburculation of corrosion products on the 
pipe walls. This increase in roughness produces a lower Hazen-Williams C-factor or 
a higher Darcy-Weisbach roughness coefficient, resulting in greater frictional head 
loss in flow through the pipe. 

5.4.4. Liquid Age and Source Tracing 

In addition to chemical transport, EPANET can also model the changes in the age of 
liquid throughout a distribution system. Liquid age is the time spent by a parcel of 
liquid in the network. New liquid entering the network from reservoirs or source nodes 
enters with age of zero. Liquid age provides a simple, non-specific measure of the 
overall quality of delivered liquid. Internally, EPANET treats age as a reactive 
constituent whose growth follows zero-order kinetics with a rate constant equal to 1 
(i.e., each second the liquid becomes a second older). 

EPANET can also perform source tracing. Source tracing tracks over time what 
percent of liquid reaching any node in the network had its origin at a particular node. 
The source node can be any node in the network, including tanks or reservoirs. 
Internally, EPANET treats this node as a constant source of a non-reacting 
constituent that enters the network with a concentration of 100. Source tracing is a 

https://epanet22.readthedocs.io/_/downloads/en/latest/pdf/#page=132&zoom=100,66,450
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useful tool for analyzing distribution systems drawing liquid from two or more different 
raw liquid supplies. It can show to what degree liquid from a given source blends with 
that from other sources, and how the spatial pattern of this blending changes over 
time 
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5.5. Rule-Based Controls syntax 

Purpose: 

Defines rule-based controls that modify links based on a combination of conditions. 

Format: 

Each rule is a series of statements of the form: 

RULE ruleID 

IF condition_1 

AND condition_2 

OR condition_3 

AND condition_4 

etc. 
 

THEN action_1 

AND action_2 

etc. 
 

ELSE action_3 

AND action_4 

etc. 
 

PRIORITY value 

 
where: 

ruleID  = an ID label assigned to the rule 
conditon_n  = a condition clause 
action_n  = an action clause 
Priority  = a priority value (e.g., a number from 1 to 5) 

 

Condition Clause Format 

A condition clause in a Rule-Based Control takes the form of: 

object id attribute relation value 

 
where: 

object = a category of network object 
id = the object’s ID label 
attribute = an attribute or property of the object 
relation = a relational operator 
value = an attribute value 

Some example conditional clauses are: 

JUNCTION 23 PRESSURE > 20 

TANK T200 FILLTIME BELOW 3.5 

LINK 44 STATUS IS OPEN 

SYSTEM DEMAND >= 1500 

SYSTEM CLOCKTIME = 7:30 AM 

The Object keyword can be any of the following: 



 PipeWeb user's guide 

- 83 - 

NODE LINK SYSTEM 

JUNCTION PIPE 
 

RESERVOIR PUMP 
 

TANK VALVE 
 

When SYSTEM is used in a condition no ID is supplied. 

The following attributes can be used with Node-type objects: 

• DEMAND 
• HEAD 
• PRESSURE 

The following attributes can be used with Tanks: 

• LEVEL 
• FILLTIME (hours needed to fill a tank) 
• DRAINTIME (hours needed to empty a tank) 

These attributes can be used with Link-Type objects: 

• FLOW 
• STATUS (OPEN, CLOSED, or ACTIVE) 
• SETTING (pump speed or valve setting) 

The SYSTEM object can use the following attributes: 

• DEMAND (total system demand) 
• TIME (hours from the start of the simulation expressed either as a 

decimal number or in hours:minutes format) 
• CLOCKTIME (24-hour clock time with AM or PM appended) 

Relation operators consist of the following: 

= IS 

<> NOT 

< BELOW 

> ABOVE 

<= >= 

 

Action Clause Format 

An action clause in a Rule-Based Control takes the form of: 

object id STATUS/SETTING IS value 

where: 

object = LINK, PIPE, PUMP, or VALVE keyword 
id = the object’s ID label 
value = a status condition (OPEN or CLOSED), pump speed setting, or valve setting 
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Some example action clauses are: 

LINK 23 STATUS IS CLOSED 

PUMP P100 SETTING IS 1.5 

VALVE 123 SETTING IS 90 

Remarks: 

1. Only the RULE, IF and THEN portions of a rule are required; the other 
portions are optional. 

2. When mixing AND and OR clauses, the OR operator has higher 
precedence than AND, i.e., 

IF A or B and C 

is equivalent to 

IF (A or B) and C. 

If the interpretation was meant to be 

IF A or (B and C) 

then this can be expressed using two rules as in 

IF A THEN ... 

IF B and C THEN ... 

3. The PRIORITY value is used to determine which rule applies when 
two or more rules require that conflicting actions be taken on a link. A 
rule without a priority value always has a lower priority than one with a 
value. For two rules with the same priority value, the rule that appears 
first is given the higher priority. 

Example: 

[RULES] 

RULE 1 

IF TANK 1 LEVEL ABOVE 19.1 

THEN PUMP 335 STATUS IS CLOSED 

AND PIPE 330 STATUS IS OPEN 

 

RULE 2 

IF SYSTEM CLOCKTIME >= 8 AM 

AND SYSTEM CLOCKTIME < 6 PM 

AND TANK 1 LEVEL BELOW 12 

THEN PUMP 335 STATUS IS OPEN 

 

RULE 3 

IF SYSTEM CLOCKTIME >= 6 PM 

OR SYSTEM CLOCKTIME < 8 AM 

AND TANK 1 LEVEL BELOW 14 

THEN PUMP 335 STATUS IS OPEN 

 

 
` 
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5.6. Transient analysis 

Sudden changes in flow velocity in a piping system for transport of liquids cause a 
pressure surge or shock wave, travelling at high speed through the system. This 
phenomenon is called hydraulic shock, or sometimes water hammer. The velocity 
changes involved are typically caused by a closing valve or a pump stop or start 
operation. Severe cases may result in loss of containment by pipe rupture or damage 
to equipment.  
 
RND PipeWeb has a transient transport model which can be used to analyze the 
behavior of hydraulic shock phenomena and the effect of mitigation measures. The 
model employs the Method of Characteristics (MOC) to solve the governing system 
of partial differential equations for continuity and momentum balance. Various friction 
models, including an advanced convolution-based model are implemented, as well 
as a model for vapor formation by cavitation. 
 
RND PipeWeb supports modeling of several surge mitigator equipment, including: 

• Surge relieve valve 

• Compressed gas accumulator vessel  

• Rupture disk 

• Standpipe 
 
The implementation of the transient model and boundary conditions are largely 
based on the methods described in:  
 
Fluid Transients in Systems. By E. B. WYLIE and V. L. STREETER. Prentice Hall, 
1993, ISBN 0-13-322173-3.  
 
Other useful resources include:  

• https://www.youtube.com/watch?v=bChifSS9oF4&ab_channel=SimpleEngine
eringSnippets 

• https://www.youtube.com/watch?v=lrt7oY5DFRQ&ab_channel=MikeCrowley 

• https://tsnet.readthedocs.io/en/latest/transient.html 

•  
 

https://en.wikipedia.org/wiki/Method_of_characteristics
https://www.youtube.com/watch?v=bChifSS9oF4&ab_channel=SimpleEngineeringSnippets
https://www.youtube.com/watch?v=bChifSS9oF4&ab_channel=SimpleEngineeringSnippets
https://www.youtube.com/watch?v=lrt7oY5DFRQ&ab_channel=MikeCrowley
https://tsnet.readthedocs.io/en/latest/transient.html


 PipeWeb user's guide 

- 86 - 

6. Tools & utilities 

The App has a variety of utilities that assist the user in project construction and 
review. The most commonly used tools are:  

• Chart configuration tool  

• Object alignment utility  

• Search utility  

• Window arrangement utility  

• Picture management 

• Preferences  
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6.1. Chart configuration 

This chapter discusses configuration properties of chart properties which affect chart 
display on the viewport. 
 
Chart properties are available when the value Chart has been selected for the Shape 
node property. The Config button adjacent to the Shape drop-down control toggles 
the display of chart properties pane.  
 
The display properties of a chart are controlled on the chart panel. The chart panel 
has four tab-pages, each presenting a specific category of chart elements.  

6.1.1. Series 

The Series tab controls the styling attributes of the individual data series of the chart. 
The series list at the top allows creation, deletion, renaming, reordering and selection 
of a series item.  
 

 
 
The properties of a single selected series are managed by the controls in the 
Line settings frame and the Marker and column settings frame, which control 
such properties as line width and the marker symbol used to indicate data points.  
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6.1.2. Captions 

The Captions tab controls the font, size and color of text displayed on the chart, as 
indicated by the labels on the tab.  
 

 
 

6.1.3. Scaling 

The Scaling tab controls scale ranges of the horizontal and vertical axes of the chart 
 
 

 
 
The text boxes labeled Formatting determine the format of the tick labels, specified 
by Number format characters as also used for clock time display format. The 
Logarithmic checkboxes independently engages a log scale for both axes. The x-
axis scale range of line charts can be focused dynamically by rotating the 
mouse wheel while hoovering over the horizontal chart axis in the viewport with the 
control and shift key both pressed. 
 

6.1.4. Appearance 

The Appearance tab controls a choice of additional decoration elements and style 
features of the chart. The check boxes are used to toggle the visibility of specific 
chart elements. The Category gap and Column spacing sliders allow adjustment of 
column width and spacing in column charts. The Block autorefresh check box 
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exempts the chart from updates by regular animation update intervals. The Reject 
data clustering check box disables data compression for accelerated  
plotting of large data sets. The Rounded line caps check box affects the line cap 
smoothness for thick line styles in line plots. 
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6.2. Curve and Pattern editor 

The Pattern editor and Curve editor can be used to create, modify, and delete 
patterns and curves respectively. Patterns are used to allow quantities to vary in time 
and to define relative locations along the length of a pipe link. Curves contain data 
pairs representing a relationship between two quantities. 
 
 

     
 
 

Validation button  
Pressing the validation button at the top left checks if the curve or pattern data 
supplied in the data list underneath the button is valid. If the curve or pattern is not 
valid, information is displayed concerning the nature of the detected error or 
inconsistency. The validation is also performed when a different curve or pattern 
object is selected by the below-mentioned Pattern\Curve object drop down menu 
and when the utility is opened.  

Pattern\Curve object 
Selects an object from the drop-down list. The selected pattern item can be 
designated Default pattern by the corresponding context popup-menu, activated by 
a right mouse button click presents. The Default Pattern is applied to the flow rate 
property (epanet project: Demand property) of all junction nodes which do not have a 
time pattern assigned to this property.  

New pattern\curve 
Press this button to create and select a new curve or pattern object. 

Pattern\Curve data list and preview chart 
Allows specification of multipliers for each time period of the pattern, or xy-data 
points for the curve. The length of the time period for patterns is determined by the 
Pattern time step property in the Scheduling tab of the Model properties console. The 
current values are displayed on the adjacent preview chart, ignoring empty lines. The 
mouse or the arrow keys can be used to change the active cell or the selected row of 
the list. If the last row is selected, pressing the Ctrl+Down arrow key adds new rows 
to the list. The context popup-menu, which is activated by a right mouse button click, 
presents additional configuration methods for the data list. For the transient valve 
characteristic curve type the contextual menu allows for switching between Kv and 
Cv definitions of the flow coefficient, as well as between absolute values and values 
as fraction of the fully opened valve maximum. Finally, the contextual menu can be 
used to adopt typical curve data for some common value types, as published in the 
Val‐Matic white paper Surge Control in Pumping Systems (relative values only). 

https://www.valmatic.com/Portals/0/pdfs/SurgeControlinPumpingSystems_6-18.pdf
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Pattern\Curve name 
Name of the pattern or curve object (maximum of 24 characters) 

Annotation  
Text line that represents a description or other information about the pattern or curve 
object. 

Close 
Saves the changes made and closes the editor utility window. The selected curve or 
pattern is assigned to the property for which the editor utility was opened. 

Cancel 
Closes the curve editor utility window without storing any changes. 
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6.3. Minor loss evaluation tool 

 
Minor losses are the pressure losses attributed flow through fittings, valves, bends, 
elbows, tees, inlets, exits and diameter changes. In large networks with long pipes, 
pressure losses due to such components are minor compared with frictional losses of 
the pipe itself. The evaluation tool allows minor loss estimation for commonly applied 
components, based on based on experimentally determined data. The tool presents 
a list of the available fitting and valves. It is opened by the Minor loss tool button on 
the Configuration window.  
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The items in the list are sorted by class and category in the third column, with a short 
type description in the last column. The table cells with a white background can be 
edited upon a mouse click on the cell. The first column specifies the number of items 
present in the selected pipe and the second column provides the applied loss 
coefficient for each item. The top row gives the resulting summations. The Reducer 
and Expander fitting types require specification of the Ratio d/D of the smaller to the 
larger pipe diameter in the fourth column, and the transition sharpness qualifier 
selected by a drop-down menu in the last column. The last three rows contain 
supplemental items with a user-specified loss coefficient in the second column and 
description in the last column. 
 
The applied values for the minor loss coefficients are based the following references: 
 
-  Perry's Chemical Engineers' Handbook. New York :McGraw-Hill, 7th ed, 1999 
-  Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper 

No. 410 
 
The table does not have an entry for the loss coefficient of a pipe exit into a tank or 
reservoir. The corresponding loss coefficient of 1.0 is automatically applied in the 
hydraulic model and needs not be specified as a minor loss. 
 
Underneath the table is a text field that permits specification of a multiplication factor 
for all loss coefficients of a selected pipe. This correction factor permits manual 
adjustment of the loss coefficients for large pipe diameters, as has been suggested 
by some publications. 
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6.4. Object alignment utility 

The alignment utility allows alignment of the position of nodes on the Viewport. It is 
activated by clicking the More... item of the Align submenu of the Format menu. 
Alignment only affects nodes selected in the Viewport. While the alignment utility is 
activated the Workspace window and all Fusion windows are disabled until the 
alignment utility is closed.  
 

 
 
The frames labeled Horizontal and Vertical determine the alignment orientation. The 
options in the Arrangement frame determine the alignment method. The default 
Align option allows alignment of the node object by the options selected in the 
adjacent Horizontal and Vertical frames. Selection of the Spread option allows 
scaling of the node arrangement by a factor specified in the Stretch factor text 
fields. The Distribute option allows rearrangement organized in rows and columns in 
the configuration specified by the items in the Distribution options frame. 

No change 
No changes are made to the node positions in either the horizontal or vertical 
direction.  

Left, Center, Right 
Aligns the horizontal position of respectively the left-most edges, the center and right-
most edges of the selected node images to the node object last selected. If all 
objects were selected by a rectangular sweep the alignment reference is the 
horizontal center of the selection. 

Top, Center, Bottom 
Aligns the vertical position of respectively the top-most edges, the center and bottom-
most edges of the selected node images to the node object last selected. If all 
objects were selected by a rectangular sweep the alignment reference is the vertical 
center of the selection. 

Stretch factor 
Scales the realignment by horizontal and vertical scaling factors 
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Row count 
Number of rows formed by the alignment.  

Column count 
Number of columns formed by the alignment.  

Square 
Rearranges the node objects into array with square outline.  

Square cells 
Rearranges the node objects into an array with square cells.  

Expand 
Increases the width or height of the selection span to obtain square or square cell 
distribution. 

Contract 
Decreases the width or height of the selection span to obtain square or square cell 
distribution. 
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6.5. Search utility 

The search utility can be used to search for objects in the viewport. It is activated by 
the Find item of the Edit menu, or by pressing the shortcut key combination <ctrl>F 
in the Viewport. The utility can be opened from the Workspace window and from a 
Fusion window. The search domain includes only objects in visible layers of the 
viewport of the window from which the utility was opened. The utility searches for a 
user-specified string. All objects that satisfy the search criterion are selected in the 
Viewport. 
 
When the utility is activated the Find window appears and the Main window and all 
Fusion windows are disabled until the search utility is closed. The utility window has 
a Search text field, where the search string is entered and two option frames which 
determine the search domain and method. 
 

 
 

6.5.1. Search options 

Use pattern matching 
Enables pattern matching using Regular expressions. 

Match case 
Enables case sensitive searching.  

Find whole words only 
Restricts the search to whole words.  

6.5.2. Search domain 

Object names 
Searches the Name property of node and link objects.  

Object tags 
Searches in Tags of node and link objects.  
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Symbol text 
Searches the Text property of node symbol objects.  
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6.6. Window arrangement utility 

The window arrangement utility can be used to arrange the various windows opened 
by the app on the monitor screen. It is activated by the Arrange Windows item of the 
Window menu.  
 
The utility window contains three frames. The Method frame determines the way the 
window rearrangement is carried out. The frame labeled Windows controls which 
windows are rearranged and determines the repositioning order of the windows. The 
Screen margins frame defines a screen area for placement of the rearranged 
windows. On a system with multiple monitors the windows are placed on the monitor 
on which the utility window is displayed.  
 

 
 

Project windows 
The list in the Project windows frame displays the name of each window of the 
project that may be subjected to rearrangement. The order of the listed items can be 
modified by drag-drop operations. The arrangement is performed for all items 
checked in the list. 

Arrangement method 
Defines the arrangement method. Application of the Cascade option stacks the 
windows in a such manner that overlap of the title bar of the rearranged windows is 
minimized. The Tile option arranges the windows in as many Rows and Columns as 
specified in the two associated text fields, in such a way that no window overlaps any 
other window. For both options the windows are uniformly resized. 

Screen margins [%] 
Defines the margins on all four edges of the target area in percentages of the screen 
height or width.  
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6.7. Picture management 

The picture management console is activated by the Pictures command of the 
Tools menu. The picture repository contains pictures that can be used to represent 
nodes in the viewport. The console has a picture repository to the left and a tab strip 
on the top right to access different picture property categories for pictures selected in 
the repository. The picture repository provides a list of the pictures in the project. 
Pictures can be added from disk by the New command of the contextual menu of the 
repository, by dropping a picture file on the repository, or by pasting a bitmap from 
the clipboard into the repository. The picture viewer on the bottom right displays the 
bitmap of the pictures selected in picture repository organized in a grid. A click on a 
picture in the picture viewer deselects all other pictures.  

6.7.1. Masking 

Transparency color 
Defines the transparency mask color of the selected picture. The transparency color 
can be selected by the color selection dialog activated by a click on the adjacent 
color display field. The transparency color can also be selected by a click on a pixel 
in the picture viewer, provided a single picture is selected in the picture repository. 
The transparency mask color is opaque and does not preserve any transparency 
information of the selected pixel.  

Layer substitution color  
Defines the mask color of the selected picture to be substituted with the color of the 
object layer. The layer color can be selected by the color selection dialog activated 
by a click on the adjacent color display field. The layer color can also be selected by 
a click on a pixel in the picture viewer while pressing the Shift key, provided a single 
picture is selected in the picture repository. The mask color is opaque and does not 
preserve any transparency information of the selected pixel. 

6.7.2. Knots 

Add knot 
Activates knot creating. Picture knots can be used as anchor for attachment of a link 
to a node represented by the picture, with the Icon fit value Filled fit selected. A click 
on the picture viewer with activated knot creating results into creation of a new knot 
in the picture on the mouse position, with the knot location indicated in pixels in the 
text fields labeled X and Y.  

Required link snap opacity 
Specifies the minimum opacity level percentage required for attachment of a link to a 
node represented by the picture. 

6.7.3. Transform  

Crop transparent edges  
Crops the picture by removing transparent edges on all four sides of the items 
selected in the picture repository.  

Replace 
Activates a file browser to select a picture file for replacement of the items selected in 
the picture repository. 
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6.8. Preferences 

The Preferences console is activated by the Preferences command of the Tools 
menu. Selecting an item in the category list at the left side of the console presents 
the corresponding properties pane at right.  
 

 
 

6.8.1. Page layout 

The page properties pane determines the page properties of the project. 
 

 
 

Size (H x W) 
Displays the page size expressed in the selected for the Project base unit. 

Page spacing 
Determines the page distance on the viewport in the value selected for the 
Project base unit. 

Show print margins 
If checked, the page margins of the selected printer are displayed by a line in the 
viewport. 
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6.8.2. Grid size 

Spacing 
Determines the distance between the grid lines in the viewport specified in the value 
selected for the Project base unit. 

Offset 
Determines the distance of the top and left grid line to the page edge specified in the 
value selected for the Project base unit. 

Page break margin 
Determines the required minimum distance to the right and bottom page edges for 
gridlines specified in the value selected for the Project base unit. 

Marker line span 
Determines the display length of the gridlines as percentage of the spacing. 

Project base unit 
Determines the base unit for size display and specification. 

6.8.3. Presentation 

Determines the display properties of the viewport. 
  

 
 

Project base font 
Determines the default font for text in the viewport. A click on the text field opens the 
font picker tool, by which the default font can be changed, 
 

Results display precision 
Determines the number of significant digits for display of numerical results. 
 

6.8.4. Enumerations 

 

Base index number 
Determines the lowest index number assigned to new link and node objects. The 
dropdown menu allows selection of the values 0 or 1. 
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Revision control 
The revision control frame determines the method by which version identification is 
organized. 

Significance levels 
Determines the revision enumeration depth. Revision enumeration is applied to 
distinguish significance levels of revisions. The lowest revision significance level can 
be updated automatically.  

Auto increment 
Determines the method for automated increment of the lowest significance 
enumeration. The dropdown menu allows selection of the values <None>, On save 
and On exit. The value <None> requires manual revision assignment by the 
contextual menu of the Revision text field. 

Display format 
Determines the revision display style in the Revision text field and by 
Viewport object text codes. The string specified in the column labeled Separator is 
shown between the significance level values. The Format column requires a 
selection out of the three characters to specify the revision display format. A series of 
hashtag characters (#) represent the minimum number of digits displayed for the 
integer number. The value A presents uppercase letters in the scheme A, B, C ... AA, 
AB... The value a presents lowercase letters by the same scheme. If no format is 
specified the revision enumeration is displayed as unformatted number. 

6.8.5. File locations 

Initial file dialog directory 

Project 
Determines the folder for the Open and Save commands of the File menu. 
 

 
 
The three options are: The Last visited folder by file operations within the app, the 
Documents folder of the operating system, and a Specified location, which is 
assigned in the adjacent text field that appears when selected.  

Pictures 
Determines the browsing folder for new pictures created by the Picture management 
utility. 

Project initialization file 
Enables loading a project file with every new project. The file and path name are 
shown in the adjacent text field. The initialization file is selected using the browse 
button to the right of the text field. 
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6.8.6. Locale 

Units system 
Determines the units of measurement preference for the application. The dropdown 
menu has the values Metric, Imperial and None. The selection affects the default 
value for the Project base unit and evaluation of standard printer paper dimensions. 
The values Metric or Imperial are recommended if high accuracy page size 
representation is expected for a matching page setup selection. 

6.8.7. Documentation 

Source Location 
Select the value Local to use the help files locally installed on the system instead of 
the default online documentation location. Available for MS-Windows only and must 
be set each time the application starts. 
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7. Appendices 

This section provides general information associated with the PipeWeb software 
application for reference.  
 

• Regular expressions 

• Text markup 
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7.1. Regular expressions 

This section describes the syntax of regular expressions.  

Pattern  Description  

.  Matches any character except newline.  

[a-z0-9]  Matches any single character of set.  

[^a-z0-9]  Matches any single character not in set.  

\d  Matches a digit. Same as [0-9].  

\D  Matches a non-digit. Same as [^0-9].  

\w  Matches an alphanumeric (word) character - [a-zA-Z0-9_].  

\W  Matches a non-word character [^a-zA-Z0-9_].  

\s  Matches a whitespace character (space, tab, newline, etc.).  

\S  Matches a non-whitespace character.  

\n  Matches a newline (line feed).  

\r  Matches a return.  

\t  Matches a tab.  

\f  Matches a form feed.  

\b  Matches a backspace.  

\0  Matches a null character.  

\000  Also matches a null character because of the following:  

\ Matches an ASCII character of that octal value.  

\xnn  Matches an ASCII character of that hexadecimal value.  

\cX  Matches an ASCII control character.  

\metachar  Matches the meta-character (e.g., \, .).  

(abc)  
Used to create subexpressions. Remembers the match for later 
backreferences. Referenced by replacement patterns that use \1, 
\2, etc.  

\1, \2,…  Matches whatever first (second, and so on) of parens matched.  

x?  Matches 0 or 1 x's, where x is any of above.  

x*  Matches 0 or more x's.  

x+  Matches 1 or more x's.  

x{m,n}  Matches at least m x's, but no more than n.  

abc  Matches all of a, b, and c in order.  

a|b|c  Matches one of a, b, or c.  

\b  Matches a word boundary (outside [] only).  
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\B  Matches a non-word boundary.  

^  Anchors match to the beginning of a line or string.  

$  Anchors match to the end of a line or string.  

 

7.1.1. Replacement Patterns 

The following expressions can only apply to the replacement pattern:  

Pattern  Description  

$'  Replaced with the entire target string before match.  

$&  The entire matched area; this is identical to \0 and $0.  

$'  Replaced with the entire target string following the matched text.  

$0-$50  
$0-$50 evaluate to nothing if the subexpression corresponding to 
the number doesn't exist.  

\0-\50   

\xnn  
Replaced with the character represented by nn in Hex, e.g., ™is 
™.  

\nnn  Replaced with the character represented by nn in Octal.  

\cX  
Replaced with the character that is the control version of X, e.g., 
\cP is DLE, data line escape.  

7.1.2. Regular Expression Examples 

The basic idea of regular expressions is that it enables you to find and replace text 
that matches the set of conditions you specify. It extends normal Search and Replace 
with pattern searching.  

Wildcards 
Some special characters are used to match a class of characters:  

Wildcard  Matches  

.  Any single character except a line break, including a space.  

If you use the "." as the search pattern, you will select the first character in the target 
string and, if you repeat the search, you will find each successive character, except 
for Return characters.  
The following wildcards match by position in a line:  

Wildcard  Matches  Example  

^  
Beginning of a line (unless used in a 
character class; see below)  

^Phone: Finds lines that begin 
with "Phone":  

$  
End of a line (unless used in a character 
class)  

$: Finds the last character in 
the current line.  

Character Classes 
A character class allows you to specify a set or range of characters. You can choose 
to either match or ignore the character class. The set of characters is enclosed in 
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brackets. If you want to ignore the character class instead of match it, precede it by a 
caret (^). Here are some examples:  

Character 
Class  

Matches  

[aeiou]  Any one of the characters a, e, i, o, u.  

[^aeiou]  Any character except a, e, i, o, u.  

[a-e]  Any character in the range a-e, inclusive  

[a-zA-Z0-9]  Any alphanumeric character.  

[[]  Finds a [.  

[]]  
Finds a ]. To find a closing bracket, place it immediately after the 
opening bracket.  

[a-e^]  
Finds a character in the range a-e or the caret character. To find the 
caret character, place it anywhere except as the first character after the 
opening bracket.  

[a-c-]  
Finds a character in the range a-c or the - sign. To match a -, place it at 
the beginning or end of the set.  

Non-printing Characters 
You can use the following notation to find non-printing characters:  

Special 
Character  

Matches  

\r  Line break (return)  

\n  Newline (line feed)  

\t  Tab  

\f  Formfeed (page break)  

\xNN  Hex code NN.  

Other Special Characters 

The following patterns are wildcards for the following special characters:  

Special 
Character  

Matches  

\s  Any whitespace character (space, tab, return, linefeed, form feed)  

\S  Any non-whitespace character.  

\w  Any "word" character (a-z, A-Z, 0-9, and _)  

\W  Any "non-word" character (All characters not included by \w).  

\d  Any digit [0-9].  

\D  Any non-digit character.  
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Repetition Characters 

Repetition characters are modifiers that allow you to repeat a specified pattern.  

Repetition 
Character  

Matches  Examples  

*  
Zero or more 
characters.  

d* finds no characters, or one or more 
consecutive "d"s.  

.* finds an entire line of text, up to but not 
including the return character.  

+  
One or more 
characters.  

d+ finds one or more consecutive "d"s.  

[0-9]+ finds a string of one or more consecutive 
numbers, such as "90404", "1938", the "32" in 
"Win32", etc.  

?  
Zero or one 
characters.  

d? finds no characters or one "d".  

Please note that, since * and ? match zero instances of the pattern, they always 
succeed but may not select any text. You can use them to specify an optional 
character, as in the examples in the following section.  

"Greediness" 

The "?" is used as a "greediness" modifier for a subpattern in a regular expression. 
You can place a "?" directly after a * or + to reverse the "greediness" setting. That is, 
if Greedy is True, using the ? after a * or + causes it to match the minimum number of 
times possible: For example, consider the following.  

Target String  Greedy  
Regular 
Expression  

Result  

aaaa  True  (a+?) (a+)  $1=a, $2=aaa  

aaaa  False  (a+?) (a+)  $1=aaa, $2=a  

Extension Mechanism 

We also support the regular expression extension mechanism used in Perl. For 
instance:  

(?#text)  Comment  

(?:pattern)  For grouping without creating backreferences  

(?=pattern)  
A zero-width positive look-ahead assertion. For example, \w+(?=\t) 
matches a word followed by a tab, without including the tab in $&.  

(?!pattern)  
A zero-width negative look-ahead assertion. For example 
foo(?!bar)/matches any occurrence of "foo" that isn't followed by 
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"bar".  

(?<=pattern)  
A zero-width positive look-behind assertion. For example, 
(?<=\t)\w+ matches a word that follows a tab, without including the 
tab in $&. Works only for fixed-width look-behind.  

(?<!pattern)  
A zero-width negative look-behind assertion. For example 
(?<!bar)foo matches any occurrence of "foo" that does not follow 
"bar". Works only for fixed-width look-behind.  

Subexpressions 

You can use parentheses within your search patterns to isolate portions of the 
matched string. You do this when you need to refer to subsections of the matched in 
your replacement string. For example, you would do this if you need to replace only a 
portion of the matched string or insert other text into the matched string.  

Here is an example. If you want to match any date followed by the letters "B.C." you 
can use the pattern "\d+\sB\.C\." (Any number of digits followed by a space character, 
followed by the letters "B.C.") This will match dates such as 33 B.C., 1742 B.C., etc. 
However, if you wanted your replacement pattern to leave the year alone but replace 
the letters with something else, you would use parens. The search pattern 
"(\d+)\s(B\.C\.)" does this.  

When you write your replacement pattern, you can refer to the year only with the 
variable \1 and the letters with \2.  

If you write "(\d+)\s(B.C.|A.D.|BC|AD)", then \2 would contain the matched letters.  

 

Combining Patterns 

Much of the power of regular expressions comes from combining these elementary 
patterns to make up complex searches. Here are some examples:  

Pattern  Matches  

\$?[0-
9,]+\.?\d*  

Matches dollar amounts with an optional dollar sign.  

\d+\sB\.C\.  One or more digits followed by a space, followed by "B.C."  

The Alternation Operator 

The alternation operator (|) allows you to match any of a number of patterns using 
the logical "or" operator. Place it between two existing patterns to match either 
pattern. You can use more than one alternation operator in a pattern:  

Pattern  Matches  

\she\s | \sshe\s  " he " or " she "  

cat|dog|possum  "cat", "dog", or "possum"  
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([0-9,]+\sB\.C\.)|([0-
9,]+\sA\.D\.) '''or''' [0-
9,]+\s((B\.C\.)|(A\.D\.))  

Years of the form "yearNum B.C. or A.D." e.g., 
"2,175 B.C." or "215 A.D."  

7.1.3. Search and Replace 

You use special patterns to represent the matched pattern. Using replacement 
patterns, you can append or prepend the matched pattern with other text.  

Pattern  Description  

$&  

Contains the entire matched pattern.  

If "\d\d\d\d\sB\.C\." finds "1541 B.C.", then the replacement pattern "the 
year $&" results in "the year 1541 B.C.", as the $& contains the string 
"1541 B.C".  

\1, \2, etc.  

Contains the matched subpatterns, defined by use of parentheses in 
the search string.  

The search pattern "(\d+)\s(B\.C\.|A\.D\.|BC|AD)" looks for any number 
of digits followed by a space character, followed by either "B.C.", "BC", 
"A.D.", or "AD". The \1 variable contains the match to the "\d+" portion 
of the expression and \2 contains the match to the "B\.C\.|A\.D\.|BC|AD" 
portion.  

 
Credits 

Philip Hazel, and copyright by the University of Cambridge, England.  
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7.2. Text markup escape sequences 

This section provides a list of escape sequences available for insertion of object or 
clock property values in tag or symbol text. An escape sequence consists of the 
backslash escape character followed by two other characters. Two consecutive 
backslashes represent a single literal backslash. 

7.2.1. Escape sequences for object properties 

An escape sequence in object property markup is replaced by a string that expresses 
a property value in the text displayed in the viewport. The following object escape 
sequences are defined in PipeWeb:  
 
Esc. seq. Description 
\OT Object type name 

\OI Object index 

\Oi Non-zero object index 

\OX Object index, not displayed if type name is unique for the object 
\OP Object icon picture name (node only) 

 
\DT Object drawing type name.  
\DI Object drawing index 

\Di Non-zero drawing index 
\DX Drawing index, not displayed if type name is unique for the drawing 
\DR Drawing revision 

 
\PN Project name 
\PR Project revision 
 
Drawing designation 
The drawing container of a node object is determined by the center of the image that 
represents the node in the viewport. The drawing object of a link is determined by the 
tag seat location of the link. If an object is positioned in the page break margin area 
between two pages the corresponding drawing escape sequence is undetermined, 
indicated by the string “<Property ref>” 
 
Page reference representations 
The lead characters O and D are case-sensitive for the index referencing sequence 
of page reference nodes. Lower case for the first character denotes the index 
property of the paired node of a paired page reference node, as opposed to the index 
property of the node itself.  


